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FlashPro Express

FlashPro Express is Microsemi’s programming tool designed from the ground up to address secured
programming assurance in production programming house environments. FlashPro Express supports
SmartFusion2, IGLOO2, RTG4, SmartFusion, IGLOO, ProASIC3, Fusion, and ProASICPLUS devices in the
Windows OS environments and supports SmartFusion2, IGLOO2, and RTG4 in the Linux OS environments.

You can install FlashPro Express two ways:
e Integrated with Libero - FlashPro Express is installed automatically when Libero is installed.

FlashPro express is used by Libero to perform the programming tasks for SmartFusion2, IGLOO2, and
RTG4, as part of the design flow.

e Stand-Alone - FlashPro Express is also available as a standalone installation. This mode is primarily
used for production programming or lab programming on machines in which a full version of Libero is
not required. When installed using the stand alone installation, FlashPro Express is joined by the
predecessor product FlashPro.

View the detailed Install Instructions and System Requirements at the Flashpro Express software page:
http://www.microsemi.com/products/fpga-soc/design-resources/programming/flashproexpress#overview

Secure Job Programming

Job programming is the concept of using a single file to program a Microsemi device or chain of Microsemi
devices using encrypted bitstreams.

The single job file contains all of the information necessary to setup FlashPro Express as well as the
encrypted bitstream images for the devices in the job. Once a job file is created it can be handed off
securely to production programming houses or contract engineering facilities to load the Microsemi images
during manufacturing. Job projects can be exported from Libero and imported into stand alone FlashPro
Express providing a clean delineation between design flow and production programming.

Migrating FlashPro Projects to FlashPro Express

Existing FlashPro projects (*.pro) files are now called Job Project files in FlashPro Express. These Job
Projects can be opened with FlashPro Express to take advantage of Linux programming support and the
simplified tool targeted for operators in a production floor environment.

FlashPro projects that were created in single mode will not be supported with this tool. Microsemi
recommends that you convert these projects to chain mode projects. To convert the project to a chain
project, do the following steps:

1. Open the FlashPro project (*.pro) in FlashPro.
2. Locate the loaded STAPL file by one of two methods:

The log will print “STAPL file ‘<stapl_path>" has been loaded successfully.” <stapl_path> is the
location of the STAPL file loaded.

cftware Versicn: 11.5.0.15

M\ |Warning: -
FL file 'D:\test_pro ctDacal\topdefaulc.sctp' has been loaded scccessfully.
DESIGH : top: CHECKSUM : F673; ALG VERSION : 2

[\ an [ Errors § Wamngs ) Info [

Within the Single Device Configuration Window there is a field STAPL_FILE_NAME, which displays the location
of the STAPL file loaded.
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Switch the project to chain mode by one of the two methods:
a. Press the chain button from the toolbar.

|

b. From the Tools menu, select Mode->Chain Programming.

Load the STAPL file in chain mode by adding a Microsemi device in the chain.

a. From the File menu, select Configuration->Add Microsemi Devices from
Files.

b. Browse to the location of the STAPL file and click Open.
To save the project, from the File menu, select Save Project.
You may now open the project using FlashPro Express.

When moving FlashPro project (*.pro) files to another machine, Microsemi recommends that you archive the
entire project folder, copy it to the new machine, extract it locally, then load the job project within FlashPro
Express. FlashPro Express will only open a job project if a programmer is connected to the machine, at least
one Microsemi device has programmed enabled, and all enabled Microsemi devices have a bitstream file
loaded.

Supported Families - FlashPro Express

FlashPro Express programs all the devices from all the following device families:

SmartFusion2 FPGAs
IGLOO2 FPGASs
RTG4 FPGAs
SmartFusion FPGAs
IGLOO FPGAs
ProASIC3 FPGAs
Fusion FPGAs

ProASIC PLUS FPGAs - FlashPro Express ONLY; not supported in Libero SOC.
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When we specify a family name, we refer to the device family and all its derivatives, unless otherwise
specified. See the table below for a list of supported device families and their derivatives:

Table 1 - Product Families and Derivatives

Device Family Description
Family Derivatives
SmartFusion2 | N/A Address fundamental requirements for advanced
security, high reliability and low power in critical
industrial, military, aviation, communications and
medical applications.
IGLOO2 N/A Low-power mixed-signal programmable solution
RTG4 N/A Radiation-tolerant programmable solution

SmartFusion

SmartFusion

SmartFusion intelligent mixed-signal FPGAs are the
only devices that integrate an FPGA, ARM Cortex-M3,
and programmable analog, offering full customization
and IP protection.

Fusion N/A Mixed-signal FPGA integrating ProASIC3 FPGA
fabric, programmable analog block, support for ARM®
Cortex M-M1 soft processors, and flash memory into a
monolithic device.
IGLOO IGLOO The ultra-low-power, programmable solution
IGLOOe Higher density IGLOO FPGAs with six PLLs and
additional 1/O standards
IGLOO nano The industry’s lowest power, smallest size solution
IGLOO PLUS | The low-power FPGA with enhanced I/O capabilities
ProASIC3 ProASIC3 The low-power, low-cost, FPGA solution
ProASIC3E Higher density ProASIC3 FPGAs with six PLLs and
additional 1/O standards
ProASIC3 Lowest cost solution with enhanced I/O capabilities
nano
ProASIC3L The FPGA that balances low power, performance,
and low cost
Automotive ProASIC3 FPGAs qualified for automotive
ProASIC3 applications
Military Military temperature A3PE600L, A3P1000, and
ProASIC3/EL | ASPE3000L
RT ProASIC3 | Radiation-tolerant RT3PE600L and RT3PE3000L
ProASIC N/A Supported by FlashPro Express ONLY- not supported
PLUS by Libero SoC.



http://www.actel.com/products/smartfusion2/default.aspx
http://www.microsemi.com/products/fpga-soc/fpga/igloo2-fpga
http://www.actel.com/products/rtg4/default.aspx
http://www.actel.com/products/smartfusion/default.aspx
http://actel.com/products/fusion/default.aspx
http://actel.com/products/iglooseries/default.aspx
http://actel.com/products/pa3series/default.aspx
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Installing FlashPro Express Software and Hardware

See the FlashPro Express Installation Instructions on the Microsemi website for information on supported
platforms, how to install FlashPro Express software/hardware and relevant system requirements.

View the detailed Install Instructions and System Requirements at the FlashPro Express software page:
http://www.microsemi.com/products/fpga-soc/design-resources/programming/FlashPro#overview



http://www.actel.com/techdocs/manuals/default.aspx
http://www.microsemi.com/products/fpga-soc/design-resources/programming/flashpro#overview

FlashPro Express for Libero SoC v11.8 User Guide C M’cmsem’

Power Matters.”

Getting Started

Starting FlashPro Express

You can start the FlashPro Express software from Programs > Microsemi FlashPro Express vx.x >
FlashPro Express. If you installed the program in a folder other than FlashPro Express, choose that folder
from the Programs menu.
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FlashPro Express Interface

The main FlashPro Express Ul consists of a list of programmers and a chain table, as shown in the figure
below. This view displays the programmers connected to the machine, and the devices within the JTAG

chain specified in the job project file (PRO) file, as shown in the figure below.

e Hover over the programmer Info icon to display more information about a programmer.

e Click the Name field to change a programmer name.

e Click the checkbox to enable or disable a programmer.

e Right-click a programmer to Ping, Self-Test, Scan, Check Chain or Remove it from the list.

e Additional information about a device and programming file, if loaded, can be viewed by hovering over
the info icon of that device.

o Devices specified as disabled in the job project (*.pro) file are shown disabled and their HighZ value is

displayed in the column header.

e Device/Programmer States:
e |IDLE: The devices/programmers are idle and not executing any programming

action.

e DISABLED: Devices that are not enabled for programming

e PASSED: The last programming operation passed
o FAILED: The last programming operation failed
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Figure 1 - FlashPro Express Programmers and Chain Table
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Creating a Job Project from a Programming Job

Once you are ready to hand off your design for production you can create a job project. To do so:

1. In Libero SoC run Export Programming Job to create a container that will be used to transfer

programming configuration information, including programming files, to the production programming
tool FlashPro Express.

# | Bxport Programming Job ==
Programming job file name:
sdl_Mss
Existing programming job Files:

E sdi_mssjob

Selected Security options (modify via Configure Security tool)
Encrypt bitstream with default key, No User keys and Security Policies are enabled.

Design bitstream file to be inchuded in the programming job
Bitstream components

File ko program at trusted Facility (7] Fabric  [J] elvm

Configured device chain with bitstream files and programmer settings will be induded in the programming job.

o] (o)

Figure 2 - Export Programming Job

1. In FlashPro Express, from the Project menu choose Create Job Project From a Programming Job.
You will be prompted to specify the Programming Job File location that you just exported from Libero
and the location of where to store the FlashPro Express Job Project. The Job Project name
automatically uses the programming job name and cannot be changed. Click OK and a new Job
Project will be created and opened for production programming.

11
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p )

[74 Create Job Project from Programming lob

Programming job file:
ClijiFPexprass_TutorialiLibero_projectM250S0T-FGEI6\designer| test | expartitest. job Browse, ..
FlashPro Express job project name:
kesk
FlashPro Express job project location:

C:lij\FPexpress_Tuborial\FPexpress_project Browse. ..

_ Hep [ ok ][ coxel |

Figure 3 - Create Job Project Dialog Box

Load a Job Project

To get started in FlashPro Express you must load a job project (*.pro file). To do so, from the Project menu
choose Open Job Project. A job project will open if:

e Atleast 1 programmer is connected
e Atleast 1 Microsemi device is enabled for programming
e Any enabled Microsemi device for programming must have a bitstream file loaded

Note: FlashPro projects (*.pro) created in single chain mode are not supported with this tool. You must
create a chain mode project with the existing programming files within FlashPro prior to using
FlashPro Express.

To open a project:

1. From the Project menu, choose Open Job Project. The Open Project dialog box appears.
2. Find your project file or type in your project file name in the File name field.
3. Click Open.

12
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[Z2 FlashPro Express = oR

Project Edit View Programmer Help

Job Projects
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Open...
Recent Projects

Log 8 x

([E]messaoes | € Erors i Wamings @ Info

Figure 4 - FlashPro Express Launch Screen

Saving a Job Project

Click the Save button on the toolbar, or from the Project menu choose Save Job Project to save your
project.

Parallel Programming with FlashPro5/4/3/3X

Parallel programming enables you to program multiple Microsemi devices in parallel with multiple
programmers. In parallel programming, all targeted devices are programmed with the same programming
file (STAPL). The targeted device or chain configuration that is connected to each programmer must be
identical.

The FlashPro Express software together with the FlashPro5/4/3/3X programmers supports parallel
programming via a USB port. You can connect up to sixteen FlashPro5/4/3/3X's to a PC via a USB v1.1 or a
USB v2.0 port. FlashPro5/4/3/3X requires a self-powered hub.

Connecting FlashPro5/4/3/3X (a USB v2.0 enabled programmer) to USB v1.1 port increases device
programming time due to a slow data transfer rate on the USB v1.1 port in comparison to a USB v2.0 port.
Note: FlashPro (USB/LPT1) or FlashPro Lite programmers do not support parallel programming.

The following figure illustrates how you can connect a FlashPro5/4/3/3X programmer for parallel
programming.

13
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Figure 5 - Connecting a FlashPro5/4/3/3X Programmer

An independent thread processes the STAPL file during parallel programming. In an Microsemi test, parallel
programming is approximately five times faster than programming 16 devices sequentially.

Note: Microsemi has tested Belkin PCI-USB cards and hubs. We have found that parallel programming
works best with the vendor's latest driver installed and with the matching hubs.

Chain Programming Tutorial

This tutorial demonstrates how to use FlashPro Express to program a multi-device, multi-programmer chain.
This tutorial uses the production programming flow that exports a programming job from Libero SoC, which
includes chain configuration, programmer settings, and bitstream files for programming, and creates a job
project from a programming job.

The figure below shows the chain used in this tutorial. M2S050T is device 1 and A3P250 is device 3. Device
1 is the first device to be programmed in the chain and device 2 is the last; device 3 is disabled and will not
be programmed.

[Z4 FlashPro Express CMif\FPexpress_Tutorial\FPexpress_project\test/test.pro

Project  Edit  View Prograrnrmer  Help

| RefreshiRescan Programmers |
5 ] mzsosoT ) P AL ; ) AIP250
Programimer
& TDO TOIl 2 & TDO T 2 4 TDO HighZ OFf TDI 2
1 (€ oesez IDLE IDLE IDLE DISABLED
z O sem IDLE ICLE IDLE DISABLED

Figure 6 - Chain Programming Devices
To program a chain:
1. From the Project menu, choose Create Job Project from Programming Job.

2. Click Browse to load a Programming Job File, and specify your FlashPro Express job project
location. Click OK to continue, as shown in the figure below.

14
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r_-"a Create lob Project from Programming lob @

Programming job file:
Ciilij\FPexpress_TuborialiLibero_project|M2zS050T-FGE96 designer|test| expartitest. job Browse...
FlashPro Express job project name:
kest
FlashPro Express job project location:

C:\lijiFPexpress_Tutorial|FPexpress_project

 Hep ok | [ cancsl |

Figure 7 - Create Job Project from Programming Job
FlashPro Express displays your Job Project and programmers, as shown in the figure below. The
Device/Programmer states are:
e IDLE: The devices/programmers are idle and not executing any programming action
e DISABLED: Devices that are not enabled for programming
e PASSED: The last programming operation passed
e FAILED: The last programming operation failed

15
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[Z2 FlashPro Express C\lij\FPexpress_Tutorial\FPexpress_projectitestitestpro

=
Project  Edit  ‘iew Programmer  Help
_Rgﬁeshﬁkﬁ:aﬂPruganlmss_
(i ] mc0s0T € awEs0 @ A3P250
Programmer
@Too0 TOIG  GTDO TDIY GTDO HighZ Off TDIG
1 O o o JoLme 0 omEe | osas
2 @@ osse2 IDLE DIE | IDLE DISABLED
PROGRAM -
IDLE
RUN ]
Log

(i) @ s waros @ o

Software Version: 11.4.0.101

STAPL file 'C:\1ij\FPexpress_Tutorial\FPexpress_project\tesat\M25050T test M25050T.stp' has been loaded
successfully.

DESIGN : test; CHECKSUM : 3A67; ALG VERSION : 2

Figure 8 - FlashPro Express with Loaded Job Project
See the Export Programming Job topic for information on how to generate a Programming Job file.

3. Click the Refresh/Rescan button if your programmer is not listed. Hover your mouse over the Info
icon to view device info. If a device is Disabled for programming the HighZ status appears in the GUI,
as shown in the figure above.

4. Set the Programming Action in the dropdown menu to PROGRAM, as shown in the figure below.

|PROGRAM -]
DEVICE_INFO
EMNC_DATA_AUTHEMTICATION
ERASE
|READ_IDCODE
g VERIFY i
Figure 9 - Programming Action Set to PROGRAM
5.

Click RUN. Detailed individual programmer and device status information appears in the Programmer

List. Your programmer status (PASSED or FAILED) appears in the Programmer Status Bar, as shown
in the figure below.

Hover your mouse over the Programmer Status Bar to display information on the programmers.
Hover over the FAILED status to list all programmers that failed programming.
Hover over the PASSED status to list all the programmers that programmed successfully.
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@ FlashPro Express C:\Iij\F'Pexpress;Tﬁtorial\FPexpress_pmjeEt\tesE\best.pro

[E=N(HeE =52
Project  Edit  View Programrmer  Help
[Rzﬁeduﬂgscunpnmyaﬂmnrs]
[ ] msosor @) amEs0 @ AP250
Programmer
@T00  TOIG S0 TG @ TDO HighZzOff TDI &
L Ov e IIGEHNN WEESN  WEEN  oseo
: 00 o I | v | oo% | | osem

[DEHCE : _ _
Log 8 X

[[E]Messages | @ Errors i, Wamnings @ 1nfo

oGRS L CERT R

Chain Programming Finished: Mon Jun 09 10:02:13 2014 (Elapsed time 00:00:00) =

e-o-0=-0-0-0 =

Figure 10 - Chain Programming Complete
View the Log for Messages, Errors, Warnings and Info generated during programming.
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Programming Settings and Operations

Introduction

The FlashPro Express software enables you to connect multiple programmers to your computer. With each
programmer you select, you can connect the programmer, perform a self-test, customize, add, and remove
and analyze the JTAG chain, as shown in the figure below.

EE FlashPro Express Z:\QTFP_testing\pc_pro_FP\m2s050_896fbga_fab\m2s050_896fbga_fab.pro

Project  Edt View Progammer  Help

Refreshifescan Programmers
MZ5050
Programmes e 4
« TDO ™S
1 ([ OE w2 ILE [ mE
: L S — g
Self Test
Scan and chedk chan
Remove
Enable/Disabile
PROGRAM -
IDLE
RUN
Log 8 x

[E]) Messages | €JErmors  f), Wamnings i) Info

STAPL file 'Z:\QTFP_teating\pc_pro_FP\mls050_896fbga_feb\projectData\sdl.stp' has been loaded successfully. -~
DESIGN : sdl; CHECKSUM : 9EDF: ALG_VERSION : 2

Driver : 3.0.0 build 1

progeammer '87272' : FlashProd

Opened 'I:/QTFP_teating/pc_pro_FP/u2s050_896fbga_fab/m2s050_896fbga_fab.pro' w

Figure 11 - FlashPro Express Right-Click Menu

Programmer Settings

The Programmer Settings dialog box includes setting options for FlashPro5/4/3/3X, FlashPro Lite and
FlashPro.

Note: You can set the TCK setting in the PDB/STAPL file by selecting the TCK frequency in the
Programmer Settings dialog box.

Limitation of the TCK frequency for the selected programmer:
e FlashPro supports 1-4 MHz
e FlashPro Lite is limited to 1, 2, or 4 MHz only.
e FlashPro5:1, 2, 3, 4, 5, 6, 10, 15, 30 MHz
e FlashPro4:1, 2, 3,4,5,6 MHz
e FlashPro3/3X: 1, 2, 3, 4, 6 MHz
Limitation of the TCK frequency for the target device:
¢ IGLOO, ProASIC3, and Fusion — 10MHz to 20MHz
e ProASICPLUS and ProASIC — 10 MHz.

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file will override the
TCK frequency setting selected by you in the Programmer Settings dialog box unless the Force TCK
Frequency checkbox is selected.

18
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To set your programmer settings:

1. From the Tools menu, choose Programmer Settings.The Programmer Settings dialog box appears
(as shown in the figure below).

#~ B
E Programmer Settings ﬁ

| FlashPro | FlashProlite | FlashPro3 | FlashProd | FlashPros

[¥] set vpump
TCK Mode

@ Free running dock Discrete docking

] Force TCK Frequency

[ hee | [ o J[ come |

Figure 12 - Programmer Settings Dialog Box for FlashPro Express

2. Click a programmer tab and check the appropriate settings for your programmer.
3. Click OK.

FlashPro Programmer Settings

Choose your programmer settings for FlashPro (see figure above). If you choose to add the Force TCK
Frequency, select the appropriate MHz frequency. After you have made your selection(s), click OK.
Default Settings
e The Vpp, Vpn, Vdd(l), and Vddp options are checked (Vddp is set to 2.5V) to instruct the FlashPro
Express programmer(s) to supply Vpp, Vpn, Vdd(l) and VVddp.

e The Drive TRST option is unchecked to instruct the FlashPro Express programmer(s) NOT to drive the
TRST pin.

e The Force TCK Frequency option is unchecked to instruct FlashPro Express to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro Lite Programmer Settings

If you choose to add the Force TCK Frequency, select the appropriate MHz frequency. After you have made
your selection(s), click OK.

Default Settings

e The Vpp and Vpn options are checked to instruct the FlashPro Express Lite programmer(s) to supply
Vpp and Vpn.

19
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e The Drive TRST option is unchecked to instruct the FlashPro Express Lite programmer(s) NOT to
drive the TRST pin.

e The Force TCK Frequency option is unchecked to instruct the FlashPro Express Lite to use the TCK
frequency specified by the Frequency statement in the STAPL file(s).

FlashPro5/4/3/3X Programmer Settings

For FlashPro5/4/3/3X, you have the option of choosing the Set Vpump setting or the Force TCK Frequency.
If you choose the Force TCK Frequency, select the appropriate MHz frequency. For FlashPro4/3X settings,
you have the option of switching the TCK mode between Free running clock and Discrete clocking. After you
have made your selections(s), click OK.

Default Settings

e The Vpump option is checked to instruct the FlashPro5/4/3/3X programmer(s) to supply Vpump to the
device.

e The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3/3X to use the TCK
frequency specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro5/4/3/3X default TCK mode setting is Free running clock

TCK Setting (ForceTCK Frequency)

If Force TCK Frequency is checked (in the Programmer Setting) then the selected TCK value is set for
the programmer and the Frequency statement in the PDB/STAPL file is ignored.

Note: FlashPro Lite RevA supports only 4MHz on TCK.

Default TCK frequency

When the PDB/STAPL file or Chain does not exist, the default TCK frequency is set to 4MHz. In the Single
Device File Programming mode, FlashPro Express will parse through the file and search for the "freq"
keyword and the "MAX_FREQ" Note field, which are expected in all Microsemi flash device files. The
FlashPro Express software uses the lesser value of the two as the default TCK frequency.

In Chain Programming mode, when more than one Microsemi flash device is targeted in the chain, the
FlashPro Express software passes through all of the files and searches for the "freq" keyword and the
"MAX_FREQ" Note field. The FlashPro Express software uses the lesser value of all the TCK frequency
settings and the "MAX_FREQ" Note field values.

Ping Programmers

To ping a programmer(s):
Right-click a programmer and choose Ping.
Note: You can click the Refresh/Rescan for Programmers button to quickly ping new programmers.

Performing a Self-Test

To perform a self-test:
Right-click the programmer you want to self-test and choose Self Test.

Note: You must connect the programmer to the self-test board that comes with your programmer before
performing a self-test.

Note: Self-test is not supported with FlashPro5/4 or FlashPro Lite programmers. These programmers are
rigorously tested at the factory during production.

20



FlashPro Express for Libero SoC v11.8 User Guide C M’cmsem’

Power Matters.”

Scanning and Checking a Chain

The scan chain operation scans and analyzes the JTAG chain connected to programmer(s) you have
selected and checks that chain scanned matches the chain configured in FlashPro Express.

To scan a chain:

Right-click the programmer you want to scan and choose Scan and check chain.

Enabling and Disabling Programmers

After loading a job project, you can enable/disable or remove a programmer and can also ping, self-test, run
scan and check chain on any of the connected programmers. These actions are available in the shortcut
menu (right-click) for each of the programmers listed in the programmer column.

Click the checkbox next to a programmer in the Programmer column to enable or disable it. The
programmer is enabled when there is a tick mark in the checkbox and disabled when the checkbox is empty.

Renaming a Programmer

Enter the new programmer name in the Programmer window to rename the programmer. By default, the
programmer name is the same as the programmer ID.

Removing a Programmer

To remove a programmer:
Right-click the programmer and choose Remove.
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Chain Programming

Chain Order

Chain Programming enables you to program several devices at one time. The order of devices in the chain
imported from Job Project must match the physical chain to be programmed.

Multiple Device Chain Programming

The TDO for the first device connects to the programmer, and the last device's TDI connects to the
programmer. The devices in the chain go in order from a device's TDI into the next device's TDO, as shown

in the figure below.
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Figure 13 - Chain Order

The FlashPro Express software enables direct chain programming without generating a chain STAPL file.
Each device will be programmed in sequential order starting from device 1 to device N. See example below.
For more information about chain order, see the Chain Order help topic.

TDI > Device N > Device N-1 >... > Device 2 > Device 1 > TDO

Device Programming Compatibility
SmartFusion2, IGLOO2, RTG4, SmartFusion, IGLOO, ProASIC3, Fusion families can be programmed in the

same chain.
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Programmer Support

FlashPro5/4/3/3X supports the SmartFusion2, IGLOO2, RTG4, SmartFusion, IGLOO, ProASIC3, Fusion
family devices. The Vpump on FlashPro5/4/3/3X is designed to support the programming of only one device.
Please make sure that Vpump, Vcc and Vjtag are provided on board for chain programming. Connect the
Vpump to the header as the Flashpro Express software will attempt to check for all external supplies,
including Vpump, to ensure successful programming. There is no limitation to the chain length; however,
ensure that the JTAG signal integrity and the timing are preserved.

Selecting an Action

FlashPro Express supports the following programming actions:

DEVICE_INFO

ENC_DATA_AUTHENTICATION - encrypted bitstream files for SmartFusion, IGLOO, ProASIC3/E and
Fusion; bitstream files for SmartFusion2, IGLOO2, and RTG4. If an enabled device for programming
does not contain this action in the chain, then the action will error out.

ERASE
PROGRAM
READ_IDCODE
VERIFY

To configure a programming action:

Select an action from the Programming Action dropdown menu in FlashPro Express, as shown in the figure
below.

|PROGRAM -]
DEVICE_INFO
EMNC_DATA_AUTHEMTICATION
ERASE
|READ_IDCCDE

g VERIFY

Figure 14 - FlashPro Express Programming Actions
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Tcl Commands - FlashPro Express

About TCL Commands - FlashPro Express Tcl Command
Reference

A Tcl (Tool Command Language) file contains scripts for simple or complex tasks. You can run scripts from
the Windows command line or store and run a series of Tcl commands in a *.tcl batch file. The Tcl
commands supported by FlashPro Express are listed in the table below.

Note: Tcl commands are case sensitive. However, their arguments are not.

Command Action
close_project Closes the FlashPro project
configure_flashpro_prg Changes FlashPro programmer settings

configure_flashpro3 prg Changes FlashPro3 programmer settings

configure_flashpro4 prg Changes FlashPro 4 programmer settings

configure_flashpro5_prg Changes FlashPro 5 programmer settings

configure flashproLite prg | Changes FlashPro Lite programmer settings

create job Create a job in FlashPro Express

dump_tcl_support

Unloads the list of supported FlashPro Tcl commands

enable_serialization

Enables or disables serialization programming.

open_project Opens a FlashPro project
ing_pr Pings one or more programmers

refresh_prg_list

Refreshes the programmer list

remove _hsm_tickets

Removes HSM tickets from the HSM

remove_pr

Removes the programmer from the programmer list

run_selected actions

Runs the selected action on the specified programmer and
returns the exit code from the action

save_log

Saves the log file

save_project

Saves the FlashPro project

scan_chain_prg

Runs scan chain on a programmer

select_serial_range

Selects the range of indexes to program.

self _test prg

Runs Self-Test on a programmer
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Command Action
set_prg_name Changes the user name of a programmer

set_programming_action Selects the action for a device

set_serialization_log_file Sets the path and name of the serialization log file.

Running Tcl Scripts from within FlashPro Express

Instead of running scripts from the command line, you can use FlashPro Express's Execute Script dialog box
to run a script.

To execute a Tcl script file within FlashPro Express:
1. From the File menu, choose Execute Script to display the Run Script dialog box.

-
E Run Script M

SciptFile: |

Arguments:

——

Figure 15 - Run Script Dialog Box

2. Click the Browse button to display the Open dialog box, in which you can navigate to the folder
containing the script file to open. When you click Open, FlashPro Express enters the full path and
script filename into the Run Script dialog box for you.

3. Inthe Arguments box, enter the arguments to pass to your Tcl script. Separate each argument by a
space character. For information about accessing arguments passed to a Tcl script, see

4, Click Run.

Running Tcl Scripts from the Command Line
You can run Tcl scripts from your Windows or Linux command line.

To execute a Tcl script file in the FlashPro Express software from a shell command line:

1. Atthe prompt, type the path to the Microsemi software followed by the word "SCRIPT" and a colon,
and then the name of the script file as follows:

<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename>

The example below executes in batch mode the script foo.tcl:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl

The example below executes in batch mode the script foo.tcl and exports the log in the file foo.txt:
<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl logfile:foo.txt

The example below executes in batch mode the script foo.tcl, creates a console where the log is
displayed briefly, and exports the log in the file foo.txt:
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<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl console_mode:brief
logfile:foo.txt

If you leave console_mode unspecified or set it to 'hide’ FlashPro Express executes without a console
window. If you want to leave the console window open you can run the script with the console_mode
parameter set to 'show', as in the following example:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl console_mode:show
logfile:foo.txt

2. If you want to pass arguments to the Tcl script from the command line, then use the "SCRIPT_ARGS"
variable as follows:

<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename> SCRIPT_ARGS: " paraml
param2 param3"

Arguments passed to a Tcl script can be accessed through the Tcl variables argc and argv. The example
below demonstrates how a Tcl script accesses these arguments:
puts "Script name: $argv0"
puts "Number of arguments: $argc"
set i 0
foreach arg $argv {
puts "Arg $i : $arg"
incr i
3
Note: Script names can contain spaces if the script name is protected with double quotes:
FPExpress script:"FPExpress tcl/foo 1.tcl"

Exporting Tcl Scripts from within FlashPro Express

To export a set of Tcl commands from the FlashPro Express history:

1. From the File menu, choose Export Script File.

2. Enter the filename and click Save. The Export Script Options dialog appears (as shown in the figure
below).

~

E Export Script @lﬂ1

Script file:  pxported. td -
Files name formatting

@ Relative file names (relative to the script file location)

Qualified file names (full path; induding directory name)

relp o J[ conce |

o

Figure 16 - Script Export Options Dialog Box

Check the Include commands from current project only to export commands of the current project
only. You can specify the filename formatting by selecting Relative filenames (relative to the current
directory) or Qualified filenames(absolute path, including the directory name).

4. Click OK.
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close_project

Closes the FlashPro or FlashPro Express project.

close_project

Arguments
None

Supported Families
All

Exceptions
None

Example
close_project

complete prog_job

& Microsemi

Power Matters.”

Tcl command; completes the current open job and generates a Job Status container including
cryptographically signed Job Ticket end certifiers and Certificates of Conformance (if enabled) of the
programmed devices. It archives ticket data from the HSM database. The resultant Job Status container can
be imported into Job Manager and validated using U-HSM. If the job status file is not specified, the
information is printed in the log window, and no Job Status container is created for subsequent verification.

The HSM Job can only be completed if the number of devices in each HSM ticket has been exhausted. If

devices remain, the job can only be terminated by using the “-terminate” option.

complete_prog_job [-job_status_file path]\
[-terminate]

NOTE: This command will fail if there are devices left in any HSM ticket and the terminate option is not used.

Arguments
[-Job_status_file path]

Full path to the output Job Status container which contains End-Job Certifier and CofCs. If not specified,

information will be printed in the log window.
[-terminate]

This option will terminate the HSM job even if there are devices left in any HSM ticket. This parameter is

optional if the number of devices in all tickets have been exhausted.

Supported Families
SmartFusion2, IGLOO2

See Also:

SPPS User Guide

User HSM Installation Guide
Manufacturer HSM Installation Guide
Job Manager User Guide
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configure_flashpro_prg

Changes FlashPro programmer settings.

configure_flashpro_prg [-vpp {ON]JOFF}] [-vpn {ON]JOFF}] [-vddl {ON]JOFF}] [-force_vddp
{ON]OFF}] [-vddp {2.5]3-3}] [-drive_trst {ON|OFF}] [-force_freq {ON|OFF}] [-freq {freq}]l

Arguments
-vpp {ON|OFF}
Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON]OFF}
Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-vddl {ON]JOFF}
Enables FlashPro programmer to drive VDDL; set to ON to drive VDDL.
-force_vddp {ON|OFF}
Enables FlashPro programmer to drive VDDP; set to ON to drive VDDP.
-vddp {2.5]3.3}
Sets VDDP to 2.5 or 3.3 volts.
-drive_trst {ON]|OFF}
Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
ProASIC™, ProASIC

Exceptions
None

Example

The following example enables the FlashPro programmer to drive the VPP, VPN, VDDL, VDDP, sets the
drive voltage to 3.3v, disables the driver for TRST, and does not force the programmer to use the TCK
frequency specified in the software.

configure_flashpro_prg —vpp {ON} —vpn {ON} —vddl {ON} —force_vddp {ON} —vddp {3.3} —
drive_trst {OFF} —force_freq {OFF}

configure_flashpro3 prg

Changes FlashPro3 programmer settings.

configure_flashpro3 prg [-vpump {ON]OFF}] [-clk _mode {discrete_clk|free_running_clk}] [-
force_freq {ON]|OFF}] [-freq {freq}]

Arguments
-vpump {ON]|OFF}
Enables FlashPro programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}
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Specifies free running or discrete TCK.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families

Exceptions

Example

SmartFusion, IGLOO, ProASIC3 and Fusion

None

The following example sets the VPUMP option to ON, TCK to free running, and uses the TCK frequency
specified in the programmer file (force_freq is set to OFF):
configure_flashpro3_prg -vpump {ON} -clk_mode {free_running_clk} -force_freq {OFF} -freq
{4}
The following example sets VPUMP to ON, TCK to discrete, forces the FlashPro software to use the TCK
frequency specified in the software (-force_freq is set to ON) at a frequency of 2 MHz.
configure_flashpro3_prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro4 prg

Changes FlashPro4 programmer settings.

configure_flashpro4 prg [-vpump {ON]OFF}] [-clk _mode {discrete_clk|free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpump {ON]OFF}

Enables FlashPro4 programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}

Specifies free running or discrete TCK.

-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families

Exceptions

SmartFusion, IGLOO, ProASIC3 and Fusion

None
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The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).
configure_flashpro4_prg -vpump {ON} -clk_mode {free_running_clk} -force_freq {OFF} -freq
{4}
The following example sets the VPUMP option to ON, uses a discrete TCK and sets force_freq to ON at 2
MHz.
configure_flashpro4_prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro5_ prg

Tcl command; changes FlashPro5 programmer settings.

configure_flashpro5_prg [-vpump {ON]JOFF}] [-clk_mode {free_running_clk}]
[-force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpump {ON]OFF}

Enables FlashPro5 programmer to drive VPUMP. Set to ON to drive VPUMP. Default is ON.
-clk_mode {free_running_clk}

Specifies free running TCK. Default is free_running_clk.

-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file. Default is OFF.

-freq {freq}
Specifies the TCK frequency in MHz. Default is 4.

Supported Families

Exceptions

Example

RT ProASIC3, SmartFusion, IGLOO, ProASIC3, Fusion, SmartFusion2, IGLOO2, RTG4

None

The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).

configure_flashpro5 prg -vpump {ON} -clk _mode {free_running_clk} -force_freq
{OFF} -freq {4}

The following example sets the VPUMP option to ON, uses a free running TCK and sets force_freq to ON at
2 MHz.

configure_flashpro5 prg -vpump {ON} -clk _mode {free_running_clk} -force_freq
{ON} -freq {2}

configure_flashproLite prg

Changes FlashPro Lite programmer settings.

configure_flashproLite _prg [-vpp {ONJOFF}] [-vpn {ON|OFF}] [-drive_trst {ON|OFF}] [-
force_freq {ON|OFF}] [-freq {freq}]
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Arguments
-vpp {ON|OFF}
Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON]OFF}
Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-drive_trst {ON]|OFF}
Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
ProASIC™2

Exceptions
None

Example

The following example sets the programmer to drive the VPP, drive VPN, drive the TRST and uses the
frequency set by the programmer file (sets force_freq to OFF):

configure_flashprolite_prg —vpp {ON} —vpn {ON} —drive_trst {ON} —force_freq {OFF}

create_job_project

Tcl command; creates a Flashpro Express job using the programming job exported from Libero.

create_job_project —job_project_location location —job_file path —overwrite 0|1

Arguments
-job_project_location location
Specifies the location for your FlashPro Express job project.
-job_file path
Path to the Libero job file that is used as input to create the Flashpro Express job project.
-overwrite 0|1
Set value to 1 to overwrite your existing job project. .

Supported Families
SmartFusion2, IGLOO2, RTG4

Exceptions
None

Example

The following example creates a job project named test.job in the \fpexpress directory. It does not
overwrite the existing job project.

create_job_project \
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-job_project_location {D:\fpexpress} \
-job_Tfile {D:\test\designer\test\export\test.job} —overwrite O\

dump_tcl _support

Unloads the list of supported FlashPro or FlashPro Express Tcl commands.

dump_tcl_support -file {file}

Arguments
-file {file}

Supported Families
All

Exceptions
None

Example

The following example dumps your Tcl commands into the file ‘tcldump.tcl’
dump_tcl_support -file {tcldump.tcl}

enable_serialization

This Tcl command enables or disables serialization programming.

enable_serialization —name {device_name} -enable {true|false}

Arguments
-name

Specifies the device name.
-enable

Enables (true) or disables (false) serialization programming.

Exceptions
Must be a Microsemi Device

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.

Example
enable_serialization -name M2S/M2GLO50{T|S|TS} -enable true

get_job_status

Tcl command; exports status of current open job. The job status contains humber of devices left for each
HSM ticket. If job status file is not specified, the information is printed in the log window.
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get_job_status [—job_status_file path] \
[-archive]

Arguments
[-job_status_file path]

Path to the output FlashPro Express job status container. The job status file can be sent to the Job
Manager application and Certificates of Conformance (if available) validated using the U-HSM.

[-archive]

Moves the HSM ticket log files from the HSM ticket database to the HSM ticket archive. The archive folder
was specified during HSM installation and setup.

NOTE: If no job_status_file is specified, the archive option prints the Certificates of Conformance in the
log window without exporting them.

Supported Families
SmartFusion2, IGLOO2

See Also

SPPS User Guide

Manufacturer HSM Installation Guide
User HSM Installation Guide

Job Manager User Guide

open_project
Opens a FlashPro or FlashPro Express project.

open_project -project {project}

Arguments
-project {project}
Specifies the location and name of the project you wish to open.

Supported Families
All

Exceptions
None

Example

Opens the 'FPPrjl.pro' project from the FPProjectl directory
open_project -project {./FPProjectl/FPPrjl.pro}

ping_prg

Pings one or more programmers.

ping_prg (-name {name})*
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Arguments
-name {name}
Specifies the programmer to be pinged. Repeat this argument for multiple programmers.

Supported Families
Al

Exceptions
None

Example

The following example pings the programmers 'FP300085' and 'FP30086'.
ping_prg —name {FP300085} —name {FP300086}

process_job request

Tcl command; processes a job request received from Job Manager. It is part of the Job Ticket generation
process.

NOTEL: This command does not require a FlashPro Express project to be created or opened.
NOTE2: HSM parameters must be configured using set_hsm_params before processing job request.
process_job_request —-request_file path \

-reply_file path \
[-overwrite_reply {TRUE | FALSE}]

Arguments
—request_file path
Full file name of job request file.
-reply_file path
Full file name of job reply file.
-overwrite_reply {TRUE | FALSE}
TRUE allows overwriting of any pre-existing reply_file.

Supported Families
SmartFusion2 and IGLOO2

Example

process_job_request \
-request_file {D:/flashpro_files/jobmgr_projectl2/cm_request.req} \
-reply_Tfile {D:/flashpro_files/jobmgr_projectl2/cm_reply.rep} \
-overwrite_reply {TRUE}

See Also

SPPS User Guide

Job Manager User Guide

set_hsm_params
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refresh_prg_list

Refreshes the programmer list. This is most often used to have FlashPro or FlashPro Express detect a
programmer that you have just connected.

refresh_prg_list

Arguments

None

Supported Families

Exceptions

Example

All

None

refresh_prg_list

remove_hsm_tickets

Tcl command; removes HSM tickets from the HSM using one of the following methods:
e By specifying the job reply file in which case all tickets that are in the reply file will be deleted.
e By specifying each of the ticket IDs value in hexadecimal string.

remove_hsm_tickets [-reply_file path] \
[-ticket_ids ticketlD+]

Arguments

—reply_file path

Full file name of job request file.
-ticket_ids ticketlD+

Hex value of each ticket ID to be removed.

Supported Families

Example

NOTES

SmartFusion2, IGLOO2

remove_hsm_tickets \
-reply_Tfile {D:flashpro_filesjobmgr_projectl2cm_reply.rep}

remove_hsm_tickets \
-ticket_ids {00000000000000000000899f252d9fb55442aa7e

00000000000000000000b6T385c6a9eeca69705¢
00000000000000000000ed5702d0b767ba686b82}

1. This command should be used very carefully since it removes HSM tickets, rendering any FlashPro
Express jobs based on those tickets to be unusable.

2. This command does not require a FlashPro Express project to be created or opened.
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See Also

SPPS User Guide

Job Manager User Guide
complete_prog_job

remove_prg

Removes the programmer from the programmer list.

remove_prg (-name {name})*

Arguments
-name {name}*
Specifies the programmer to be removed. You can repeat this argument for multiple programmers.

Supported Families
Al

Exceptions
None

Example
The following example removes the programmer '03178' from the programmer list:
remove_prg (name {03178})*

run_selected_actions

Runs the selected action on the specified programmer and returns the exit code from the action. If no
programmer name is specified, the action is run on all connected programmers. Only one exit code is
returned, so return code cannot be used when action is run on more than one programmer. A
programming file must be loaded.

run_selected_actions [(-name {name})*]

Arguments
-name {name}

Optional argument that specifies the programmer name. You can repeat this argument for multiple
programmers.

Supported Families
Al

Exceptions
None

Example
The following example runs the selected actionS on the programmers 'FP30085' and 'FP30086'".
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run_selected_actions —name {FP300085} —name {FP300086%}
Example using return code:

if {[catch {run_selected_actions} return_val]} {puts "Error running Action"} else {puts
"exit code $return_val"}

Example returning exit code to the command line (returns exit 99 on script failure, otherwise returns exit
code from selected action):

if {[catch {run_selected_actions} return_val]}{exit 99} else {exit $return_val}

save log

Saves the log file.

save_log -file {file}

Arguments
-file {file}
Specifies the log filename.

Supported Families
Al

Exceptions
None

Example

The following example saves the log file with the name 'my_logfilel.log":
save_log -file {my_logfilel.log}

save_project

Saves the FlashPro or FlashPro Express project.

save_project

Arguments
None

Supported Families
All

Exceptions
None

Example
save_project
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scan_chain_prg

In single mode, this command runs scan chain on a programmer.
In chain mode, this command runs scan and check chain on a programmer if devices have been added in
the grid.

scan_chain_prg [(-name {name})+]

Arguments
-name {name}
Specifies the programmer name.

Supported Families
All

Exceptions
None

Example

The following example runs scan chain on a single programmer (single mode) named '21428":
scan_chain_prg -name {21428}

select_serial_range

This Tcl command selects the range of indexes to program.

select_serial_range -name device _name -from data start_index_ to program -to_data
end_index_to_program

Arguments
-name
Specifies the device name.
-from_data
Specifies the start index to program.
-to_data
Specifies the end index.

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.

Exceptions
Must be a Microsemi Device

Example
select_serial_range -name M2S/M2GLOSO{T|S|TS} -from data 3 -to_data 5
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self test prg

Runs Self-Test on a programmer.

self_test_prg (-name {name})*

Arguments
-name {name}
Specifies the programmer name. You can repeat this argument for multiple programmers.

Supported Families
Al

Exceptions
None

Example

The following examples runs the self test on the programmer '30175"
self_test_prg (-name {30175})*

set_hsm_params

Tcl command; saves the HSM parameters for the FlashPro Express application. These parameters remain
in effect until overridden by another invocation of this command.

set_hsm_params —hsm_server_name hsm_server \
-hsm_type_u {TRUE|FALSE} \
-m_hsm_uuid m_uuid \
-ftp_username ftp_username \
-ftp_password ftp_password

NOTEL: The HSM parameters are persistent between multiple FlashPro Express sessions on the same
computer.

NOTE2: HSM parameters only need to be set for HSM flow jobs.

Arguments
-hsm_server hsm_server
Name or IP address of HSM server computer
-hsm_type_u {TRUE]|FALSE}
TRUE FlashPro Express will use the Manufacturer features of the User HSM.
FALSE FlashPro Express will use a Manufacturer HSM.
-m_hsm_uuid m_uuid
UUID of HSM to be used for FlashPro Express tasks.
-ftp_username ftp_username
User name to access the HSM files via FTP server.
-ftp_password ftp_password
Password to access the HSM files via FTP server.

Supported Families
SmartFusion2 and IGLOO2
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Example

set_hsm_params -hsm_server_name {10.241.140.224} \
-hsm_type_u {0} \
-m_hsm_uuid {0000000000000000000000000000000000000002} \
-ftp_username {hsm} \
-ftp_password {hsm}

set_prg_name

Changes the user name of a programmer.

set_prg_name -name {name} -new_name {new_name}

Arguments
-name {name}
Identifies the old programmer name.
-new_name {new_name}
Specifies the new programmer name.

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

The following example changes the name of the programmer 'FP300086' to 'FP3Prg2":
set_prg_name —name {FP300086} —new_name {FP3Prg2}

set_programming_action

Selects the action for a device. The device name parameter must be specified only in chain programming
mode. A programming file must be loaded. The device must be a Microsemidevice.

set_programming_action [-name {name}] -action {action}

Arguments
-name {name}
Specifies the device name.
-action {action}
Specifies the action.

Supported Families
SmartFusion, IGLOO, ProASIC3, Fusion

Exceptions
Must be a Microsemi device
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Example
The following example sets the programming action in single programming mode:
set_programming_action —action {PROGRAM}
And in chain programming mode:
set_programming_action —name {MyDevicel} —action {ERASE}

set_programming_file
Sets the programming file for a device. Either the file orthe no_file flag must be specified. A

programming file must be loaded. The device must be a Microsemi device .

set_programming_Ffile [-name {name}] [-Ffile {file}] [-no_file { }]

Arguments
-name {name}
Specifies the device name. This argument must be specified only in chain programming mode.
—file {File}
Specifies the programming file.
-no_File
Specifies to unload the current programming file.

Supported Families
SmartFusion, IGLOO, ProASIC3, Fusion

Exceptions
Must be a Microsemi device.

Examples
In single programming mode:
set_programming_file —file {e:/design/pdb/TopA3P250.pdb}

In chain programming mode:
set_programming_file —name {MyDevice2} —File {e:/design/pdb/TopA3P250.pdb}
set_programming_file —name {MyDevicel} —no_Tfile

set_serialization_log_file

This Tcl command sets the path and name of the serialization log file.

set_serialization_log_file -file {log file path}

Arguments
-file
Specifies the serialization log file path and name

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.
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set_serialization_log_file -file {C:/local_z_folder/work/my_serial_log}

Exit Codes (SmartFusion2 and IGLOQO2)

Error Exit Exit Message Possible Cause Possible Solution
Code |Code
0 Passed (no - -
error)
0x8001 (-24 Failure to read Device is in System TRSTB should be driven
DSN Controller Suspend High or disable "System
Mode Controller Suspend Mode".
Check board
connections
0x8002 |5 Failure to Unstable voltage level | Monitor related power
configure device Signal integrity issues supplies that cause the issue
programming at | on JTAG pins during programming; check
1.2/12.0 VCC for transients outside of
voltage Microsemi specifications.
See your device datasheet
for more information on
transient specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.
0x8032 |5 Device is busy Unstable VDDIx Monitor related power
voltage level supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications.
See your device datasheet
for more information on
transient specifications.
0x8003 |5 Failed to enter Unstable voltage level | Monitor related power

programming
mode

Signal integrity issues
on JTAG pins

DEVRST_N is tied to
LOW

supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications.
See your device datasheet
for more information on
transient specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
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Error
Code

Exit
Code

Exit Message

Possible Cause

Possible Solution

noise or reflection.

Tie DEVRST_N to HIGH
prior to programming the
device.

0x8004

Failed to verify
IDCODE

Incorrect programming
file

Incorrect device in
chain

Signal integrity issues
on JTAG pins

Choose the correct
programming file and select
the correct device in the
chain.

Measure JTAG pins and
noise for reflection. If TRST
is left floating then add pull-
up to pin.

Reduce the length of Ground
connection.

0x8005
0x8006

10

Failed to
program eNVM

Unstable voltage level.
Signal integrity issues
on JTAG pins.

Monitor related power
supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications.
See your device datasheet
for more information on
transient specifications.

Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.

0x8007

11

Failed to verify
FPGA Array
Failed to verify
Fabric
Configuration
Failed to verify
Security

Device is programmed
with a different design
or the component is
blank.

Unstable voltage level.

Signal integrity issues
on JTAG pins.

Verify the device is
programmed with the correct
data/design.

Monitor related power
supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications.
See your device datasheet
for more information on
transient specifications.

Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.

0x8008
0x8009

11

Failed to verify
eNVM

Device is programmed
with a different design.

Unstable voltage
levelSignal integrity

Verify the device is
programmed with the correct
data/design.

Monitor related power
supplies that cause the issue

Power Matters.”
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Exit Message

Possible Cause

Possible Solution

issues on JTAG pins.

during programming; check
for transients outside of
Microsemi specifications.
See your device datasheet
for more information on
transient specifications.

Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.

Failed to unlock
User Pass Key 1

Pass key in file does
not match device

Plaintext pass key
match is disabled. This
occurs if HSM was
used to program the
device.

Provide a programming file
with a pass key that matches
pass key programmed into
the device.

Match pass key using HSM.

Failed to unlock
User Pass Key 2

Pass key in file does
not match device

Plaintext pass key
match is disabled. This
occurs if HSM was
used to program the
device.

Provide a programming file
with a pass key that matches
pass key programmed into
the device.

Match pass key using HSM.

Failed to unlock
debug pass key

Pass key in file does
not match device

Plaintext pass key
match is disabled. This
occurs if HSM was
used to program the
device.

Provide a programming file
with a pass key that matches
pass key programmed into
the device.

Match pass key using HSM.

Digest request
from SPIIJTAG
is protected by
User Pass Key 1

Digest request from
SPI/JTAG is protected
by user pass key 1.
Lock bit has been
configured in the
Debug Policy within
SPM (Security Policy
Manager)

Provide a programming file
with a pass key that matches
pass key programmed into
the device.

Error | Exit

Code |Code
0x8010 |-35
0x8011 |-35
0x8012 | -35
0x8013 | -18
0x8014 |-19

Failed to verify
digest

Unstable voltage level

Signal integrity issues
on JTAG pins

Monitor related power
supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications.
See your device datasheet
for more information on
transient specifications.

Monitor JTAG supply pins
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Error Exit Exit Message Possible Cause Possible Solution
Code |Code
during programming;
measure JTAG signals for
noise or reflection.
0x8015 |-20 FPGA Fabric Programming bitstream | Use the same programming
digest components do not file that was used to program
verification: FAIL | match components the device.
programmed
FPGA Fabric is either
erased or the data has
been corrupted or
tampered with
0x8016 |-20 eNVM_0 digest | Programming bitstream | Use the same programming
verification: FAIL | components do not file that was used to program
match components the device.
programmed
eNVM_0 data has been
corrupted or tampered
with
0x8017 |-20 eNVM_1 digest | Programming bitstream [ Use the same programming
verification: FAIL | components do not file that was used to program
match components the device.
programmed
eNVM_1 data has been
corrupted or tampered
with
0x8018 | -20 User security Programming bitstream | Use the same programming
policies segment | components do not file that was used to program
digest match components the device.
verification: FAIL | programmed
User security policy
segment data has been
corrupted or tampered
with
0x8019 |-20 User key set 1 Programming bitstream | Use the same programming
segment digest | components do not file that was used to program
verification: FAIL | match components the device.
programmed
User key set 1 segment
data has been
corrupted or tampered
with
O0x801A | -20 User key set 2 Programming bitstream | Use the same programming
segment digest | components do not file that was used to program
verification: FAIL | match components the device.
programmed

Power Matters.”
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Error Exit Exit Message Possible Cause Possible Solution
Code |Code
User key set 2 segment
data has been
corrupted or tampered
with
0x801B | -20 Factory row and | Programming bitstream | Use the same programming
factory key components do not file that was used to program
segment digest | match components the device.
verification: FAIL | programmed
Factory row and factory
key segment data has
been corrupted or
tampered with
0x801C | -20 Fabric Programming bitstream | Use the same programming
configuration components do not file that was used to program
segment digest | match components the device.
verification: FAIL | programmed.
Fabric configuration
segment data has been
corrupted or tampered
with
0x801D | -21 Device security | The device is protected | Run DEVICE_INFO to view
O0x801E prevented with user pass key 1 security features that are
operation and the bitstream file protected.
does not contain user | proyide a bitstream file with
pass key 1. a user pass key 1 that
User pass key 1 in the | matches the user pass key 1
bitstream file does not | programmed into the device.
match the device.
0x801F |-22 Authentication eNVM has been locked | Release the lock on the
0x8020 Error by a master in your eNVM after your master has
Bitstream or data | d€sign completed its access
is corrupted or | Running VERIFY action | operations. Write 0x00 to
noisy on a blank device. REQACCESS" register in
Bitst file has b eNVM Control Registers
Cc')rsr retaerg ie nas been | address 0x600801FC) to
up release the access.
Bitstream was . .
. " ted Program the device prior to
incorrectly generate running VERIFY action
Regenerate bitstream file.
0x8021 |-23 Authentication File contains an Provide a programming file
0x8022 Error encrypted key that with an encryption key that

Invalid/Corrupted
encryption key

does not match the
device

Attempting to erase a
device with no security
using master security

matches that on the device.

Run DEVICE_INFO action to
verify that the device has no
security. If the device does
not have secuirty, you

Power Matters.”
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Error Exit Exit Message Possible Cause Possible Solution
Code |Code
file cannot erase it.
File contains user First program security with
encryption key, but master programming file,
device has not been then program with user
programmed with the encryption 1/2 field update
user encryption key programming files.
Device has user You must first ERASE
encryption key 1/2 security with the master
enforced and you are security file, then you can
attempting to reprogram new security
reprogram security settings.
settings
0x8023 | -24 Authentication Design version is not Generate a programming file
0x8024 Error higher than the back- with a design version higher
Back level not level programmed than the back level version.
satisfied device
0x8025 | -25 Authentication DSN specified in Use the correct
0x8026 Error programming file does | programming file with a DSN
DSN binding not match the device that matches the DSN of the
mismatch being programmed target device being
programmed.
0x8027 |-26 Authentication Device does not Generate a programming file
0x8028 Error support the capabilities | with the correct capabilities
Insufficient specified in for the target device.
device programming file
capabilities
0x8029 | -27 Authentication Incorrect programming | Choose the correct
0x802A Error file programming file and select
Incorrect Incorrect device in the correct device in chain.
DEVICEID chain Measure JTAG pins and
Signal integrity issues | noise or reflection. If TRST is
on JTAG pins left floating, then add pull-up
to pin.
Reduce the length of ground
connection.
0x802B | -28 Authentication Programming file Generate programming file
0x802C Error version is out of date with latest version of Libero
Programming file SoC.
is out of date,
please
regenerate
0x802F | -30 JTAG interface Invalid or no UPK1 is User needs to provide
is protected by provided correct UPK1 to unlock
UPK1 device.
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Error Exit Exit Message Possible Cause Possible Solution
Code |Code
0x8030 |-31 Authentication M2S090 Rev. A or User can program a valid
0x8031 Error M2S150 Rev. A: Either | application code. This can
Invalid or certificate is corrupted | be done with SoftConsole.
inaccessible orthe userhasnt | FAB RESET N should be
Device provided the application | tied to HIGH.
Certificate code in the eNVM or
provided invalid
application code
FAB_RESET_N is tied
to ground
0x8032 | -32 Instruction timed | Unstable voltage level | Monitor related power
0x8033 out Signal integrity issues supplies that cause the issue
0x8034 on JTAG pins during programming; check
0x8035 for transients outside of
0x8036 Microsemi specifications.
0x8037 See your device datasheet
0x8038 for more information on
0x8039 transient specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.
0x8040 |-22 Authentication eNVM has been locked | Release the lock on the
Error by a master in your eNVM after your master has
Bitstream or data | d€sign completed its access
is corrupted or | Running VERIFY action | Operations. Write 0x00 to
noisy on a blank device. REQACCESS' register in
Bitst file has b eNVM Control Registers
s retarg ie has been | 5ddress 0x600801FC) to
corrupte release the access.
Bitstream was . .
. Program the device prior to
incorrectly generated running VERIFY action
Regenerate bitstream file.
0x8041 |-23 Authentication File contains an Provide a programming file

Error

Invalid/Corrupted
encryption key

encrypted key that
does not match the
device

File contains user
encryption key, but
device has not been
programmed with the
user encryption key

Attempting to erase a
device with no security
using master security
file

Device has user
encryption key 1/2
enforced and you are

with an encryption key that
matches that on the device.

Run DEVICE_INFO action to
verify that the device has no
security. If the device does
not have secuirty, you
cannot erase it.

First program security with
master programming file,
then program with user
encryption 1/2 field update
programming files.

You must first ERASE
security with the master
security file, then you can
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Error Exit Exit Message Possible Cause Possible Solution
Code |Code
attempting to reprogram new security
reprogram security settings.
settings
0x8042 |-24 Authentication Design version is not Generate a programming file
Error higher than the back- with a design version higher
Back level not level programmed than the back level version.
satisfied device
0x8043 | -25 Authentication DSN specified in Use the correct
Error programming file does | programming file with a DSN
DSN binding not match the device that matches the DSN of the
mismatch being programmed target device being
programmed.
0x8044 | -26 Authentication Device does not Generate a programming file
Error support the capabilities | with the correct capabilities
Insufficient specified in for the target device.
device programming file
capabilities
0x8045 | -27 Authentication Incorrect programming | Choose the correct
Error file programming file and select
Incorrect Incorrect device in the correct device in chain.
DEVICEID chain Measure JTAG pins and
Signal integrity issues noise or reflection. If TRST is
on JTAG pins left floating, then add pull-up
to pin.
Reduce the length of ground
connection.
0x8046 |-28 Authentication Old programming file Generate programming file
Error with latest version of Libero
Unsupported SoC.
bitstream
protocol version
0x8048 | -31 Authentication M2S090 Rev. A or User can program a valid
Error M2S150 Rev. A: Either | application code. This can
Invalid or certificate is corrupted | be done with SoftConsole.
inaccessible orthe userhasnt | FAB RESET N should be
Device provided the application | tied to HIGH.
Certificate code in the eNVM or
provided invalid
application code
FAB_RESET_N is tied
to ground
0x8049 (11 Failed to verify Device is programmed | Verify the device is
eNVM with a different design. | programmed with the correct

Power Matters.”
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Error Exit Exit Message Possible Cause Possible Solution
Code |Code
Unstable voltage level. | data/design.
Signal integrity issues | Monitor related power
on JTAG pins. supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications.
See your device datasheet
for more information on
transient specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.
8x804A |10 Failed to Unstable voltage level. | Monitor related power
program eNVM | gignal integrity issues | SUPPlies that cause the issue
on JTAG pins. during programming; check
for transients outside of
Microsemi specifications.
See your device datasheet
for more information on
transient specifications.
Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.
0x804B | -21 Device security | The device is protected | RunDEVICE_INFO to view
prevented with user pass key 1 security features that are
operation and the bitstream file protected.
does not contain user | provide a bitstream file with
pass key 1. a user pass key 1 that
User pass key 1 in the | matches the user pass key 1
bitstream file does not | programmed into the device.
match the device.
0x804C |11 Failed to verify Device is programmed | Verify the device is

FPGA Array

Failed to verify
Fabric
Configuration

Failed to verify
Security

with a different design
or the component is
blank.

Unstable voltage level.

Signal integrity issues
on JTAG pins.

programmed with the correct
data/design.

Monitor related power
supplies that cause the issue
during programming; check
for transients outside of
Microsemi specifications.
See your device datasheet
for more information on
transient specifications.

Monitor JTAG supply pins
during programming;
measure JTAG signals for
noise or reflection.

Power Matters.”
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has Security

Error Exit Exit Message Possible Cause Possible Solution
Code |Code
0x804D |-36 <HSM related HSM communication Check if HSM the
error message error. HSM call returns | communication path to HSM
based on error. is up. Make sure project is
scenario> loaded properly and that
HSM tickets have not been
cleaned.
Ox804E | -37 Device already HSM flow doesn’t Erase security and try

support reprogramming

programming the device.

programmed.
Please erase the
device using

device directly if it has
Security programmed.

master file
before

Security
Settings.

reprogramming

version

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the
STAPL standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.

Table 2 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in Software v8.6 and Above

S.

ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0 Passed (no
error)
1 A physical Physical chain configuration has
chain does been altered. Something has
not match the [ become disconnected in the chain.
expected set | The specific IR length of non-
up from the Microsemi devices may be
STAPL file. incorrect.
Also known The order of the specified chain
as Checking | may be incorrect.
Chain Error.
0x8052 5 Failed to Unstable VPUMP voltage level. Monitor related power supplies
enter that cause the issue during
programming | Unstable VCC programming; check for
mode. transients outside of Microsemi
Signal integrity issues on JTAG specifications. See your device
pins. datasheet for more information
on transient specifications.

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for
Software v8.6 and Above

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in software v8.6
and ABOVE only. See the Device Exit Codes for pre-v8.6 Software help topic for exit codes for older
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message

Device is in FlashFreeze mode

(ProASICL or IGLOO devices) Monitor VITAG during
programming; measure JTAG

Older software or programming file | signals for noise or reflection.

used.

Disble the FlashFreeze pin
(ProASICL or IGLOO devices)
Generate STAPL file with the
latest version of
Designer/FlashPro.
Use latest version of FlashPro
software.

0x801D 6 Failed to Incorrect programming file Choose the correct

0x8053 verify programming file and select the

IDCODE Incorrect device in chain correct device in chain.

Signal integrity issues on JTAG pins | Measure JTAG pins and noise
or reflection. If TRST is left
floating then add pull-up to pin.
Reduce the length of ground
connection.

0x8005 6 Failed to Programming file generated with an | Generate STAPL file with the
0x8009 verify AES older version of software latest version of
0x800B Sec. Designer/FlashPro. Use latest
version of FlashPro software.
Try again at a slower TCK.
Contact Microsemi Technical
Support.
0x8008 6 Failed to File is not for M7, but target device | Check that the target device is
verify is M7 M7 enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the
Targetis an | pins. programming file you generated
M7 device is for an M7-enabled device.
Measure JTAG pins, noise and
reflection.
0x800A 6 Failed to Files not for M1, but target device is | Check that the target device is
verify M1. M1 enabled.
IDCODE
Signal integrity issues on JTAG pins | Make sure the programming file
Target is an generated is for an M1-enabled
M1 device device.

Monitor VITAG during
programming; measure JTAG
signals for noise or reflection.
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0x800C 6 Failed to File is not for target device. Check the target device; make
verify sure the programming file
IDCODE. Signal integrity issues on JTAG pins | generated is matches the target
device.
Core enabled
device Monitor VITAG during
detected programming; measure JTAG
signals for noise or reflection.
0x800D 6 Failed to File is for M7 but target device is not | Check that the target device is
verify M7. not M7 enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the
The targetis | pins. programming file generated is
not M7 for non-M7 enabled device.
device
Monitor VITAG during
programming; measure JTAG
signals for noise or reflection.
0x800E 6 Failed to File is for M1, but target device is Check that the target device is
verify not M1. not M1 enabled.
IDCODE.
Signal integrity issues on JTAG pins | Make sure that the generated
Target is not programming file is for non-M1
an M1 device enabled device.
Monitor VITAG during
programming; measure JTAG
signals for noise or reflection.
0x8006 6 Failed to File is not for P1, but target device | Check that the target device is
verify is a P1 device. P1 enabled.
IDCODE.
Signal integrity issues on JTAG pins | Make sure programming file
Target is not generated is for M1 enabled
a P1 device device.
Monitor VITAG during
programming; measure JTAG
signals for noise or reflection.
0x801E 6 A3PE600 Contact Microsemi Technical
Engineering Support
Sample
Device
Detected.
This device is
supported
with pre-v8.3
SP1 STAPL
files only
0x8057 8 Failed Erase | Unstable VPUMP voltage level. Monitor related power supplies
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
Operation. that cause the issue during
Unstable VCC programming; check for
transients outside of Microsemi
Unstable VCC_OSC (Fusion only) specifications. See your device
datasheet for more information
Unstable VCC_ROSC voltage level [ on transient specifications.
(SmartFusion only)
Monitor VITAG during
Signal integrity issues on JTAG programming; measure JTAG
pins. signals for noise or reflection.
0x8058 10 Failed to Monitor related power supplies
program Unstable VPUMP voltage level. that cause the issue during
FPGA array programming; check for
at row <row Unstable VCC transients outside of Microsemi
number>. specifications. See your device
Unstable VCC_OSC (Fusion only) datasheet for more information
on transient specifications.
Unstable VCC_ROSC voltage level
(SmartFusion only) Monitor VITAG during
programming; measure JTAG
Signal integrity issues on JTAG signals for noise or reflection.
pins.
0x805D 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies
0x805E enable FPGA that cause the issue during
0x807B Array. Unstable VCC programming; check for
transients outside of Microsemi
Unstable VCC_OSC (Fusion only) specifications. See your device
datasheet for more information
Unstable VCC_ROSC voltage level [ on transient specifications.
(SmartFusion only)
Monitor VITAG during
Signal integrity issues on JTAG programming; measure JTAG
pins. signals for noise or reflection.
0x8095 10 Failed to Monitor related power supplies
0x8096 disable FPGA | Unstable VPUMP voltage level. that cause the issue during
0x8097 Array. programming; check for
Unstable VCC transients outside of Microsemi
specifications. See your device
Unstable VCC_OSC (Fusion only) datasheet for more information
on transient specifications.
Unstable VCC_ROSC voltage level
(SmartFusion only) Monitor VITAG during
programming; measure JTAG
Signal integrity issues on JTAG signals for noise or reflection.
pins.
0x8061 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies
0x8062 program that cause the issue during
FlashROM. Unstable VCC programming; check for

Unstable VCC_OSC (Fusion only)

transients outside of Microsemi
specifications. See your device
datasheet for more information
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
Unstable VCC_ROSC voltage level [ on transient specifications.
(SmartFusion only)
Monitor VITAG during
Signal integrity issues on JTAG programming; measure JTAG
pins. signals for noise or reflection.
0x801B 10 Error Unstable VCC_NVM/VCC_OSC Monitor related power supplies
0x801C programming | voltage level (Fusion only) that cause the issue during
0x806C Embedded programming; check for
0x806D Flash Unstable transients outside of Microsemi
0x806E Memory VCC_ENVM/VCC_RCOSC voltage | specifications. See your device
Block (EFMB) | level (SmartFusion only) datasheet for more information
on transient specifications.
Signal integrity issues on JTAG pins
Monitor VITAG during
NVM corruption is possible when programming; measure JTAG
writing from your design; check the | signals for noise or reflection.
NVM status for confirmation.
Reset signal is not properly tied
off in your design.
Inspect device using Device
Debug.
0x807D 10 Error Unstable VCC Monitor related power supplies
0x807E programming that cause the issue during
system init Unstable VCC_OSC (Fusion only) programming; check for
and boot transients outside of Microsemi
clients Unstable VCC_ROSC voltage level [ specifications. See your device
(SmartFusion only) datasheet for more information
on transient specifications.
Signal integrity issues on JTAG pins
Monitor VITAG during
programming; measure JTAG
signals for noise or reflection.
Inspect device using Device
Debug.
0x8069 10 Error Programming file generated with an | Generate STAPL file with the
0x806A programming | older version of software latest version of
0x806B Embedded Designer/FlashPro; use the
Flash latest version of FlashPro
Memory software
Block (EMFB)
Try again at a slower TCK
Inspect device using Device
Debug.
Contact Microsemi Technical
Support
0x808E 10 Error Try reprogramming
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0x808F programming
0x8090 Embedded Contact Microsemi Technical
0x8091 Flash Support
Memory
Block (EFMB)
0x807F 10 Error Programming file generated with an | Generate STAPL file with the
0x8080 programming | older version of software latest version of
system init Designer/FlashPro; use the
and boot latest version of FlashPro
clients software
Try again at a slower TCK
Inspect device using Device
Debug.
Contact Microsemi Technical
Support
0x8059 11 Verify O failed | Unstable VPUMP voltage level. Monitor related power supplies
0x805B at row <row that cause the issue during
number> Unstable VCC programming; check for
transients outside of Microsemi
Verify 1 Unstable VCC_OSC (Fusion only) specifications. See your device
failed at row datasheet for more information
<row Unstable VCC_ROSC voltage level [ on transient specifications.
number>. (SmartFusion only)
Monitor VITAG during
Signal integrity issues on JTAG programming; measure JTAG
pins. signals for noise or reflection.
0x8060 11 Device is programmed with a Run VERIFY_DEVICE_INFO to
Failed to different design. verify the device is programmed
verify with the correct data/design.
FlashROM at | Unstable VPUMP voltage level.
row Monitor related power supplies
<FlashROM | Unstable VCC that cause the issue during
row number>. programming; check for
Unstable VCC_OSC (Fusion only) transients outside of Microsemi
specifications. See your device
Unstable VCC_ROSC voltage level | datasheet for more information
(SmartFusion only) on transient specifications.
Signal integrity issues on JTAG Monitor VITAG during
pins. programming; measure JTAG
signals for noise or reflection.
0x8075 11 Failed to Device is programmed with a Verify the device is
0x8076 verify different design. programmed with the correct
0x8077 Embedded data/design.
Flash Unstable VCC
Memory Monitor related power supplies
Block (EFMB) | Unstable VCC_NVM/VCC_OSC that cause the issue during

(Fusion only)

programming; check for
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
transients outside of Microsemi
Unstable VCC_ENVM/VCC_ROSC | specifications. See your device
voltage level (SmartFusion only) datasheet for more information
on transient specifications.
Signal integrity issues on JTAG
pins. Measure JTAG pins, and noise
or reflection.
The EFMB data was modified in
your FPGA design after Run DEVICE_INFO to confirm if
programming. This could have the target EFMB block is locked
occurred during standalone verify. with FlashLock (pass key). If the
target EFMB block is locked,
The target EFMB is locked with then you must unlock it by
FlashLock when running ACTION erasing the security and then
PROGRAM_NVM_ACTIVE_ARRAY | reprogramming with the desired
or VERIFY_NVM_ACTIVE_ARRAY. | security settings. After
unlocking the target EFMB
block attempt to rerun the target
ACTION.
Inspect device using Device
Debug.
0x8085 11 Failed to Device is programmed with a Verify the device is
0x8086 verify system | different design. programmed with the correct
init and boot data/design.
clients Unstable VCC
Monitor related power supplies
Unstable VCC_NVM/VCC_OSC that cause the issue during
(Fusion only) programming; check for
transients outside of Microsemi
Unstable VCC_ENVM/VCC_ROSC | specifications. See your device
voltage level (SmartFusion only) datasheet for more information
on transient specifications.
Signal integrity issues on JTAG
pins. Measure JTAG pins, and noise
or reflection.
The EFMB data was modified in
your FPGA design after Run DEVICE_INFO to confirm if
programming. This could have the target EFMB block is locked
occurred during standalone verify. with FlashLock (pass key). If the
target EFMB block is locked,
The target EFMB is locked with then you must unlock it by
FlashLock when running ACTION erasing the security and then
PROGRAM_NVM_ACTIVE_ARRAY | reprogramming with the desired
or VERIFY_NVM_ACTIVE_ARRAY. | security settings. After
unlocking the target EFMB
block attempt to rerun the target
ACTION.
Inspect device using Device
Debug.
0x8072 11 Failed to Programming file generated with an | Generate STAPL file with the
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
0x8073 verify older version of software latest version of
0x8074 Embedded Designer/FlashPro; use the
Flash latest version of FlashPro
Memory software
Block (EFMB)
Try again at a slower TCK
Inspect device using Device
Debug.
Contact Microsemi Technical
Support
0x8083 11 Failed to Programming file generated with an | Generate STAPL file with the
0x8084 verify system | older version of software latest version of
init and boot Designer/FlashPro; use the
clients latest version of FlashPro
software
Try again at a slower TCK
Inspect device using Device
Debug.
Contact Microsemi Technical
Support
0x8014 11 Failed to Unstable VCC Monitor related power supplies
0x8015 verify that cause the issue during
calibration Unstable VCC_NVM/VCC_OSC programming; check for
data (Fusion only) transients outside of Microsemi
specifications. See your device
Unstable VCC_ENVM/VCC_ROSC | datasheet for more information
voltage level (SmartFusion only) on transient specifications.
Signal integrity issues on JTAG pins | Monitor VJTAG during
programming; measure JTAG
signals for noise or reflection.
Try reprogramming.
Workaround: Disable optional
procedure
CHECK_AND_BACKUP_CALIB
0x805A 11 Verify O failed | Device is programmed with a Run VERIFY_DEVICE_INFO to
0x805C at row <row | different design verify the device is programmed
number> . with the correct data/design.
Unstable VPUMP voltage level.
Verify 1 failed Monitor related power supplies
at row <row Unstable VCC that cause the issue during
number> programming; check for

Unstable VCC_OSC (Fusion only)

Unstable VCC_ROSC voltage level

transients outside of Microsemi
specifications. See your device
datasheet for more information
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
(SmartFusion only) on transient specifications.
Signal integrity issues on JTAG pins | Monitor VJTAG during
programming; measure JTAG
signals for noise or reflection.
0x8063 14 Failed to Signal integrity issues on JTAG Monitor related power supplies
program pins. that cause the issue during
Silicon programming; check for
Signature. transients outside of Microsemi
Failed to specifications. See your device
program datasheet for more information
security lock on transient specifications.
settings.
Monitor VITAG during
programming; measure JTAG
signals for noise or reflection.
0x8068 -18 Failed to Incorrect AES key. Generate a programming file
authenticate with the correct AES key.
the encrypted | Signal integrity issues on JTAG
data. pins. Monitor VITAG during
programming; measure JTAG
signals for noise or reflection.
0x805F -20 Failed to Programming file generated with an | Generate STAPL file with the
verify older version of software latest version of
FlashROM at Designer/FlashPro; use the
row Device is programmed with a latest version of FlashPro
<FlashROM | different design. software.
row number>.
Unstable VPUMP voltage level. Program with the correct
data/design.
Unstable VCC
Monitor related power supplies
Unstable VCC_OSC (Fusion only) that cause the issue during
programming; check for
Unstable VCC_ROSC voltage level | transients outside of Microsemi
(SmartFusion only) specifications. See your device
datasheet for more information
Signal integrity issues on JTAG on transient specifications.
pins.
Measure JTAG pins and noise
or reflection.
0x8065 -22 Failed to Unstable VPUMP voltage level. Monitor related power supplies
program pass that cause the issue during
key. Unstable VCC programming; check for
transients outside of Microsemi
Unstable VCC_OSC (Fusion only) specifications. See your device
datasheet for more information
Unstable VCC_ROSC voltage level [ on transient specifications.
(SmartFusion only)
Monitor VITAG during
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
Signal integrity issues on JTAG programming; measure JTAG
pins. signals for noise or reflection.
0x8066 -23 Failed to Unstable VPUMP voltage level. Monitor related power supplies
program AES that cause the issue during
key. Unstable VCC programming; check for
transients outside of Microsemi
Unstable VCC_OSC (Fusion only) specifications. See your device
datasheet for more information
Unstable VCC_ROSC voltage level [ on transient specifications.
(SmartFusion only)
Measure JTAG pins and noise
Signal integrity issues on JTAG or reflection.
pins.
0x8055 -24 Failed to Unstable VPUMP voltage level. Monitor related power supplies
0x8056 program that cause the issue during
UROW. Unstable VCC programming; check for
transients outside of Microsemi
Unstable VCC_OSC (Fusion only) specifications. See your device
datasheet for more information
Unstable VCC_ROSC voltage level [ on transient specifications.
(SmartFusion only)
Monitor VITAG during
Signal integrity issues on JTAG programming; measure JTAG
pins. signals for noise or reflection.
Make sure you mounted 0.01pF
and 0.33uF caps on Vpump
(close to the pin).
0x802A -27 FlashROM File contains no passkey and device | Provide a programming file with
Write/Erase is secured with a passkey. a passkey that matches the
is protected passkey programmed into the
by the Passkey in the file does not match | device.
passkey. device.
A valid
passkey
needs to be
provided.
0x8025 -28 FPGA Array | File contains no passkey and device | Provide a programming file with
Write/Erase is secured with a passkey. a passkey that matches the
is protected Passkey in the file does not match | passkey programmed into the
by the device. device.
passkey.
A valid pass
key needs to
be provided.
0x802B -29 FlashROM File contains no passkey and device | Provide a programming file with
0x802D Read is is secured with a passkey. a pass key that matches the
protected by [ Passkey in the file does not match | passkey programmed into the
passkey. device. device
A valid
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Code Message

passkey
needs to be
provided.
0x8024 -30 FPGA Array | File contains no passkey and device | Provide a programming file with
0x8026 verification is | is secured with a passkey. a passkey that matches the
protected by | Passkey in the file does not match | passkey programmed into the
a passkey. device. device.
A valid
passkey
needs to be
provided.

-31 Failed to AES key in the file does not match | Provide a programming file with
0x804B verify AES the device. an AES key that matches the
0x8001 key. AES key programmed into the
0x8007 Unstable VCC device.

Unstable VCC_OSC (Fusion only) Monitor related power supplies
that cause the issue during
Unstable VCC_ROSC voltage level | programming; check for
(SmartFusion only) transients outside of Microsemi
specifications. See your device
Unstable JTAG/VPUMP voltage datasheet for more information
level. on transient specifications.
Monitor VITAG during
programming; measure JTAG
signals for noise or reflection.
0x8000 -31 Failed to Programming file generated with an | Generate STAPL file with the
verify AES older version of software latest version of
key. Designer/FlashPro; use the
latest version of FlashPro
software.
Try again at a slower TCK
Contact Microsemi Technical
Support
0x8020 -33 FPGA Array | File contains unencrypted array Provide a programming file with
0x8022 encryption is | data, but device contains AES key. | an encrypted FPGA Array data.
0x8028 enforced. A
programming
file with
encrypted
FPGA array
data needs to
be provided.
0x802C -34 FlashROM File contains unencrypted Provide a programming file with
0x802F encryption is | FlashROM data, but the device an encrypted FlashROM data.
enforced. A contains an AES key.
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ERROR_CODE | Exit Exit Possible Cause Possible Solution
Code Message
programming
file with
encrypted
FlashROM
data needs to
be provided.
0x801F -35 Failed to Pass key in file does not match Provide a programming file with
0x804A match pass pass key in device. a pass key that matches the
key. pass key programmed into the
device.
0x802E -36 FlashROM File contains encrypted FlashROM, | Regenerate security
0x8030 Encryption is | but device encryption is not programming file with proper
not enforced. | enforced for FlashROM AES key.
Cannot Program device security.
guarantee
valid AES key Retry programming FlashROM
present in with encrypted programming
target device. file.
Unable to
proceed with
Encrypted
FlashROM
programming.
0x8021 -37 FPGA Array | File contains encrypted FPGA Regenerate security
0x8023 Encryption is | Array, but the device encryption is programming file with proper
0x8027 not enforced. | not enforced for FPGA Array. AES key.
0x8029
Cannot Program device security.
guarantee
valid AES key Retry programming FPGA Array
present in with encrypted programming
target device. file.
Unable to
proceed with
Encrypted
FPGA Array
verification.
0x8067 -38 Failed to Unstable VPUMP voltage level. Monitor related power supplies

program pass
key.

Unstable VCC
Unstable VCC_OSC (Fusion only)

Unstable VCC_ROSC voltage level
(SmartFusion only)

Signal integrity issues on JTAG
pins.

that cause the issue during
programming; check for
transients outside of Microsemi
specifications. See your device
datasheet for more information
on transient specifications.

Measure JTAG pins and noise
or reflection.
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Code Message
Bad device.
0x806F -39 ERROR: 2 or | Unstable VCC_NVM/VCC_OSC Monitor related power supplies
0x8070 more errors voltage (Fusion only) that cause the issue during
0x8071 found on this programming; check for
0x8081 page Unstable VCC_ENVM/VCC_ROSC | transients outside of Microsemi
0x8082 (SmartFusion only) specifications. See your device
0x8089 datasheet for more information
NVM reset signal is floating in user | on transient specifications.
design
Bias NVM reset to a logic state
2 or more ECC errors found when in user design.
reading the eNVM
Try reprogramming.
0x8010 -39 ERROR: 2 or | 2 or more ECC errors found when The master calibration data has
more errors reading the master calibration data | been corrupted. Try restoring
found on this master calibration from backup,
page. if it exists, by running
RECOVER_CALIB.
Workaround: Disable optional
procedure
CHECK_AND_BACKUP_CALIB
0x8013 -39 ERROR: 2 or | 2 or more ECC errors found when Rerun action to attempt to write
more errors verifying the backup calibration backup calibration again.
found on this
page. Workaround: Disable optional
procedure
CHECK_AND_BACKUP_CALIB
0x8078 -40 Embedded Data in the file is encrypted with a Verify the programming file is
0x8079 Flash different AES key than the device. generated from the latest
0x807A Memory version of Designer/FlashPro.
0x8087 Block MAC
0x8088 Failure.
0x8002 -42 Failed to File security settings do not match Provide a programming file with
0x8003 verify security | device. security setting that match the
settings. security settings programmed
into the device.
0x8093 -42 Failed to Device eNVM/EFMB client JTAG Verify the device is
verify protection settings are not programmed with the correct
eNVM/EFMB | programmed or are programmed eNVM/EFMB client JTAG
client JTAG with different settings protection settings
protection
settings
0x8004 -43 Failed to File checksum and design name do | Verify the device is
verify design | not match the device. programmed with the correct
information. data and design.
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Exit
Code

Exit
Message

Possible Cause

Possible Solution

0x8049

Failed to
verify AES
key.

The AES key in the file does not
match the AES key in the device.
File does not contain an AES key
and the device is secured with an
AES key.

Provide a programming file with
an AES key that matches the
AES key programmed into the
device.

0x8054

Device
package
does not
match the
programming
file.

Programming file was generated
with an older version of software

Generate STAPL file with the
latest version of
Designer/FlashPro; use the
latest version of FlashPro
software.

0x8033
0x8038
0x803D
0x8042
0x8045
0x8046
0x8047
0x8048

Embedded
Flash
Memory
Block X Read
is protected
by pass key.
A valid pass
key needs to
be provided.

File contains no pass key or
incorrect pass key but EFMB read is
secured with a pass key.

Provide a programming file with
the correct pass key.

0x8034
0x8039
0x803E
0x8043

Embedded
Flash
Memory
Block (EFMB)
block X Read
is not
protected by
pass key.

EFMB
content is not
secure after
encrypted
programming.

Unable to
proceed with
encrypted
NVM
programming.

File contains encrypted EFMB for
block X but the device encryption is
not enforced for EFMB block X.

Regenerate security
programming file with the
proper AES key.

Program device security. Retry
programming with EFMB block
X with encrypted programming
file.

0x8032
0x8037
0x803C
0x8041

Embedded
Flash
Memory
Block (EFMB)
block X
encryption is
enforced. A
programming
file with
encrypted

The programming EFMB data is not
encrypted, but the device contains
an AES key with encryption
enforced.

Provide a programming file with
encrypted EFMB data.
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Code Message
EFMB data
needs to be
provided.
0x8031 -48 Embedded File contains no pass key or Provide a programming file with
0x8036 Flash incorrect pass key, but device is a passkey that matches the
0x803B Memory secured with a pass key. passkey programmed into the
0x8040 Block (EFMB) device.
block X Write
is protected
by pass key.
A valid pass
key needs to
be provided.
0x8035 -49 Embedded File contains encrypted EFMB for Regenerate security
0x803A Flash block X, but the device encryption is | programming file with proper
0x803F Memory not enforced for EFMB block X. AES key.
0x8044 Block (EFMB)
block X Program device security. Retry
Encryption is programming EFMB block X
not enforced. with encrypted programming
file.
Cannot
guarantee
valid AES key
present in
target device.
Unable to
proceed with
Encrypted
EFMB
programming.
0x801A -50 No backup No backup calibration copy has If master copy is still intact,
calibration been made or the backup copy has [ rerun Action to create backup
data found or | been corrupted calibration copy.
backup
calibration Workaround: Disable optional
data has procedure
been CHECK_AND_BACKUP_CALIB
corrupted
8x804E -51 Failed to This version of the silicon does not | If programming the EFMB while
access support programming of the the FPGA is active is not
Embedded Embedded Flash Memory Block required, then use actions
Flash while the FPGA Array is active. PROGRAM_NVM or
Memory. VERIFY_NVM. Otherwise, use
(AFS600 latest revision of silicon.
only)
0x804F -52 Failed to This version of the silicon does not | If programming the EFMB while
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Code Message
access support programming of the the FPGA is active is not
Embedded Embedded Flash Memory Block required, then use actions
Flash while the FPGA Array is active. PROGRAM_NVM or
Memory. VERIFY_NVM. Otherwise, use
(AFS1500 latest revision of silicon.
only)
0x8050 -53 Failed to This version of the silicon does not | If programming the EFMB while
access support programming block 3 of the |the FPGA is active is not
Embedded EFMBs while the FPGA Array is required, then use actions
Flash active. PROGRAM_NVM or
Memory. VERIFY_NVM. Otherwise, use
(AFS1500 EFMB blocks 0, 1, or 2, but do
only) not use block 3.
0x8051 -54 Failed to FPGA Array is accessing the target [ If programming the EFMB while
access EFMB block while attempting the FPGA is active is not
Embedded programming. required, then use actions
Flash PROGRAM_NVM or
Memory. NVM reset signal is stuck in design. | VERIFY_NVM. Otherwise,
check the FPGA design or use
Unstable VCC a different EFMB block that is
not being accessed. Check if
MSS Clock is disabled during target EFMB block logic is tied
programming. to reset.
MSS Clock is not properly routed to | Monitor related power supplies
the correct pin. that cause the issue during
programming; check for
transients outside of Microsemi
specifications. See your device
datasheet for more information
on transient specifications.
Verify that the NVM reset signal
in the design is not stuck.
Verify the MSS clock is enabled
during programming.
If the MSS clock is defined as
an external 1/0O, then verify that
it is properly routed to the
correct pin.
0x808A -55 Failed to read | Programming file generated with an | Generate STAPL file with the
0x8094 Embedded older version of software latest version of
Flash Designer/FlashPro; use the
Memory latest version of FlashPro

Block (EFMB)

software
Try again at a slower TCK

Inspect device using Device
Debug
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Code Message
Contact Microsemi Technical
Support
0x808B -55 Failed to read | Unstable VPUMP voltage level. Monitor related power supplies
Embedded that cause the issue during
Flash Unstable VCC programming; check for
Memory transients outside of Microsemi
Block (EFMB) | Unstable VCC_OSC (Fusion only) specifications. See your device
datasheet for more information
Unstable VCC_ROSC voltage level [ on transient specifications.
(SmartFusion only)
Monitor VITAG during
Signal integrity issues on JTAG pins | programming; measure JTAG
signals for noise or reflection.
0x808C -55 Failed to read | Internal errror Contact Microsemi Technical
Embedded Support
Flash
Memory
Block (EFMB)
0x8011 -56 Failed to read Try reprogramming.
calibration
data Workaround: Disable optional
procedure
CHECK_AND_BACKUP_CALIB
0x8012 -56 Failed to read | Unstable VCC Monitor related power supplies
calibration that cause the issue during
data Unstable VCC_NVM/VCC_OSC programming; check for
(Fusion only) transients outside of Microsemi
specifications. See your device
Unstable VCC_ENVM/VCC_ROSC | datasheet for more information
voltage level (SmartFusion only) on transient specifications.
Signal integrity issues on JTAG pins | Measure JTAG voltages, noise,
and reflection.
Try reprogramming.
Workaround: Disable optional
backup procedure
CHECK_BACKUP_CALIB
0x808D -57 eNVM/EFMB | File contains no Pass Key and Provide a programming file with
0x8092 is protected device is secured with a Pass Key a Pass Key that matches the
by a Pass Pass Key programmed into the
Key; you Pass Key in the file does not match | device
must provide [ device
a valid Pass
Key
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SmartFusion, IGLOO, ProASIC3 and FusionDevice Exit Codes for
pre-v8.6 Software

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in pre-v8.6 software
only. This includes v8.5 SP2, v8.5 SP1, v8.5, etc. See the Device Exit Codes for Software v8.6 and Above
help topic for exit codes for older versions.

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the
STAPL standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.

Table 3 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in pre-v8.6 Software

Exit Exit Message Possible Cause Possible Solution

Code

0 Passed (no error).

1 A physical chain Physical chain configuration has
does not match the | been altered. Something has
expected set up become disconnected in the chain.
from the STAPL The specific IR length of non-
file. Microsemi devices may be
Also known as incorrect.

Checking Chain The order of the specified chain

Error. may be incorrect.

5 Failed to enter Monitor VPUMP voltage
programming Unstable VPUMP voltage level. during programming
mode.

Signal integrity issues on JTAG Measure JTAG

pins. voltages, noise, and
reflection.

Older software or programming file

used. Generate STAPL file
with the latest version of
Designer/FlashPro.
Use latest version of
FlashPro software.

6 Failed to verify Measure JTAG pins,
IDCODE. Signal integrity issues on JTAG noise and reflection.

pins.

8 Failed Erase Signal integrity issues on JTAG Monitor VPUMP voltage
Operation. pins. during programming.

Measure JTAG
voltages, noise, and
reflection.

10 Failed to program | Signal integrity issues on JTAG Monitor VPUMP voltage
FPGA array at row | pins. during programming.

" rowNumber,"." Measure JTAG
voltages, noise, or
reflection.

10 Failed to enable Signal integrity issues on JTAG Monitor VPUMP voltage
FPGA Array. pins. during programming.

Measure JTAG
voltages, noise, or
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Exit Exit Message Possible Cause Possible Solution

Code

reflection.

10 Failed to program | Signal integrity issues on JTAG Monitor VPUMP voltage

FlashROM. pins. during programming.
Measure JTAG
voltages, noise, and
reflection.

11 Verify 0 failed at Device is programmed with a Run
row",rowNumber,"." | different design. VERIFY_DEVICE_INFO
Verify 1 failed at to verify the device is
row",rowNumber,"." | Signal integrity issues on JTAG programmed with the

Failed to verify pins. correct data/design.
FlashROM at Monitor VPUMP voltage
row",from during programming.
rowNumber-1. Measure JTAG

voltages, noise and
reflection .

14 Failed to program | Signal integrity issues on JTAG Monitor VPUMP voltage
Silicon Signature. | pins. during programming.
Failed to program Measure JTAG
security lock voltages, noise, and
settings. reflection.

-18 Failed to Incorrect AES key. Generate a
authenticate the programming file with
encrypted data. Signal integrity issues on JTAG the correct AES key.

pins.
Measure JTAG
voltages, noise and
reflection

-20 Failed to verify Device is programmed with a Program with the
FlashROM at row | different design. correct data/design.
FRomRowNumber- | Signal integrity issues on JTAG Monitor VPUMP level
1. pins. during programming.

Measure JTAG pins and
noise or reflection.

-22 Failed to program | Unstable VPUMP voltage level. Monitor VPUMP voltage
pass key. during programming.

Signal integrity issues on JTAG

pins. Measure JTAG
voltages, noise, and
reflection.

-23 Failed to program Unstable VPUMP voltage level. Monitor VPUMP
AES key. voltage during

Signal integrity issues on JTAG programming.

pins.
Measure JTAG pins
and noise or reflection.
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Exit Exit Message Possible Cause Possible Solution

Code

-24 Failed to program | Unstable VPUMP voltage level. Monitor VPUMP voltage
UROW. during programming.

Signal integrity issues on JTAG

pins. Measure JTAG
voltages, noise, and
reflection.
Make sure you mounted
0.01iF and 0.33iF caps
on Vpump (close to the
pin).

-25 Failed to enter Signal integrity issues on JTAG Measure JTAG
programming mode | pins. voltages, noise, and

reflection.

-26 Failed to enter Signal integrity issues on JTAG Measure JTAG
programming mode | pins. voltages, noise, and

reflection.

-27 FlashROM File contains no passkey and device | Provide a programming
Write/Erase is is secured with a passkey. file with a passkey that
protected by the Passkey in the file does not match | matches the passkey
passkey. device. programmed into the
A valid passkey device.
needs to be
provided.

-28 FPGA Array File contains no passkey and device | Provide a programming
Write/Erase is is secured with a passkey. file with a passkey that
protected by the Passkey in the file does not match | matches the passkey
passkey. device. programmed into the
A valid pass key device.
needs to be
provided.

-29 FlashROM Read is | File contains no passkey and device | Provide a programming
protected by is secured with a passkey. file with a pass key that
passkey. Passkey in the file does not match matches the passkey
A valid passkey device. programmed into the
needs to be device
provided.

-30 FPGA Array File contains no passkey and device | Provide a programming
verification is is secured with a passkey. file with a passkey that
protected by a Passkey in the file does not match | matches the passkey
passkey. device. programmed into the
A valid passkey device.
needs to be
provided.

-31 Failed to verify AES key in the file does not match | Provide a programming

AES key.

the device.

Unstable JTAG/VPUMP voltage

file with an AES key that
matches the AES key
programmed into the

Power Matters.”

70



FlashPro Express for Libero SoC v11.8 User Guide

& Microsemi

Exit
Code

Exit Message

Possible Cause

Possible Solution

level.

device.

Monitor
VPUMP/VVJITAG voltage
during programming.

Measure JTAG
voltages, noise, and
reflection.

Failed to verify
IDCODE.
Target is an M7
device

File is not for M7, but target device
is an M7.

Signal integrity issues on JTAG
pins.

Check that the target
device is M7 enabled.
Make sure
programming file
generated is for M7
enabled device.

Measure JTAG pins ,
noise, and reflection.

Failed to verify
IDCODE.
Target is an M1
device

File is not for M1, but target device
is an M1 device.

Signal integrity issues on JTAG
pins.

Check that the target
device is M1 enabled.
Make sure programming
file generated is for M1
enabled device.

Measure JTAG pins,
noise, and reflection.

Failed to verify
IDCODE.

Core enabled
device detected

File is not for target device.

Signal integrity issues on JTAG pins

Check the target device.
Make sure programming
file generated for target
device.

Measure JTAG
voltages, noise, and
reflection.

Failed to verify
IDCODE.

The target is not
an M7 device

File is for M7, but target device is
not M7.

Signal integrity issues on JTAG
pins.

Check that the target
device is not M7
enabled.

Make sure programming
file generated is for non
M7 enabled device.

Measure JTAG
voltages, noise, and
reflection.

Failed to verify
IDCODE.

The target is not an
M1 device

File is for M1, but target device is
not an M1 device.

Signal integrity issues on JTAG
pins.

Check that the target
device is not M1
enabled.

Make sure
programming file
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Exit Exit Message Possible Cause Possible Solution

Code

generated is for non M1
enabled device.
Measure JTAG
voltages, noise and
reflection.

-33 FPGA Array File contains unencrypted array Provide a programming
encryption is data, but device contains AES key. | file with an encrypted
enforced. A FPGA Array data.
programming file
with encrypted
FPGA array data
needs to be
provided.

-34 FlashROM File contains unencrypted Provide a programming
encryption is FlashROM data, but the device file with an encrypted
enforced. A contains an AES key. FlashROM data.
programming file
with encrypted
FlashROM data
needs to be
provided.

-35 Failed to match Pass key in file does not match Provide a programming
pass key. pass key in device. file with a pass key that

matches the pass key
programmed into the
device.

-36 FlashROM File contains encrypted FlashROM, | Regenerate security
Encryption is not but device encryption is not programming file with
enforced. enforced for FlashROM proper AES key.
Cannot guarantee Program device
valid AES key security.
present in target
device. Retry programming

FlashROM with
Unable to proceed encrypted programming
with Encrypted file.
FlashROM
programming.

-37 FPGA Array File contains encrypted FPGA Regenerate security
Encryption is not Array, but the device encryption is programming file with
enforced. not enforced for FPGA Array. proper AES key.

Cannot guarantee
valid AES key
present in target
device.

Unable to proceed

Program device
security.

Retry programming
FPGA Array with
encrypted programming
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Exit
Code

Exit Message

Possible Cause

Possible Solution

with Encrypted
FPGA Array
verification.

file.

Failed to program
pass key.

Unstable VPUMP voltage level.

Signal integrity issues on JTAG
pins.
Bad device.

Monitor VPUMP voltage
during programming.

Measure JTAG pins
and noise or reflection.

Failed to verify
Embedded Flash
Memory Block
(EFMB).

Device is programmed with a
different design.

Signal integrity issues on JTAG
pins.

The EFMB data was modified
through user FPGA design after
programming; this could occur
during standalone verify.

The target EFMB block is locked
with FlashLock when running
ACTION
PROGRAM_NVM_ACTIVE_ARRAY
or VERIFY_NVM_ACTIVE_ARRAY.

Verify the device is
programmed with the
correct data/design.

Monitor VPUMP
voltage during
programming.

Measure JTAG pins
and noise or reflection.

Run DEVICE_INFO to
confirm if the target
EFMB block is locked
with FlashLock (pass
key). If the target EFMB
block is locked, then
you must unlock it by
erasing the security and
then reprogramming
with the desired security
settings. After unlocking
the target EFMB block
attempt to rerun the
target ACTION.

Embedded Flash
Memory Block
MAC Failure.

Data in the file is encrypted with a
different AES key than the device.

Verify the programming
file is generated from
the latest version of
Designer/FlashPro.

Error programming
Embedded Flash
Memory Block.
(EFMB)

Signal integrity issues on JTAG
pins.

Measure JTAG pins and
noise or reflection.

Failed to verify
security settings.

File security settings do not match
device.

Provide a programming
file with security setting
that match the security
settings programmed
into the device.

Failed to verify

design information.

File checksum and design name do
not match the device.

Verify the device is
programmed with the
correct data and design.
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Exit
Code

Exit Message

Possible Cause

Possible Solution

Failed to verify
AES key.

The AES key in the file does not
match the AES key in the device.
File does not contain an AES key
and the device is secured with an
AES key.

Provide a programming
file with an AES key that
matches the AES key
programmed into the
device.

Device package
does not match the
programming file.

Embedded Flash
Memory Block X
Read is protected
by pass key. A
valid pass key
needs to be
provided.

File contains no pass key or
incorrect pass key but EFMB read is
secured with a pass key.

Provide a programming
file with the correct pass
key.

Embedded Flash
Memory Block,
block X encryption
is enforced. A
programming file
with encrypted
EFMB data needs
to be provided.

The programming EFMB data is not
encrypted, but the device contains
an AES key with encryption
enforced.

Provide a programming
file with encrypted
EFMB data.

Embedded Flash
Memory Block
(EFMB) block X
Write is protected
by pass key.

A valid pass key
needs to be
provided.

File contains no pass key or
incorrect pass key, but device is
secured with a pass key.

Provide a programming
file with a passkey that
matches the passkey
programmed into the
device.

Embedded Flash
Memory Block
(EFMB) block X
Encryption is not
enforced.

Cannot guarantee
valid AES key
present in target
device.

Unable to proceed
with Encrypted
EFMB
programming.

File contains encrypted EFMB for
block X, but the device encryption is
not enforced for EFMB block X.

Regenerate security
programming file with
proper AES key.

Program device
security. Retry
programming EFMB
block X with encrypted
programming file.

Failed to access

This version of the silicon does not

If programming the
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The table below lists the exit codes for ProASIC
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Exit
Code

Exit Message

Possible Cause

Possible Solution

Embedded Flash
Memory.
(AFS600 only)

support programming of the
Embedded Flash Memory Block
while the FPGA Array is active.

EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, use latest
revision of silicon.

-52 Failed to access
Embedded Flash
Memory.
(AFS1500 only)

This version of the silicon does not
support programming of the
Embedded Flash Memory Block
while the FPGA Array is active.

If programming the
EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, use latest
revision of silicon.

-53 Failed to access
Embedded Flash
Memory.
(AFS1500 only)

This version of the silicon does not
support programming block 3 of the
EFMBs while the FPGA Array is
active.

If programming the
EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, use EFMB
blocks O, 1, or 2, but do
not use block 3.

-54 Failed to access
Embedded Flash
Memory.

FPGA Array is accessing the target
EFMB block while attempting
programming.

NVM reset signal is stuck in design.

If programming the
EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, check the
FPGA design or use a
different EFMB block
that is not being
accessed. Check if
target EFMB block logic
is tied to reset.

Verify that the NVM
reset signal in the
design is not stuck.

PLUS devices.

Table 4 - ProASIC " Family Devices Exit Codes

Exit Code

Exit Message

Possible Cause

Possible Solution
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Exit Code

Exit Message

Possible Cause

Possible Solution

0 This message
means passed.
This does not
indicate an error.

1 A physical chain Physical chain
does not match the | configuration has been
expected set up altered. Something has
from the STAPL become disconnected in
file. the chain.

Also known as The specific IR length of
Checking Chain non-Microsemi devices
Error. may be incorrect.
The order of the
specified chain may be
incorrect.

2 There is a reading | The device either does Check the device ID.

device ID failure. not have a valid device
ID or the data cannot be
read correctly.

3 This occurs when | Connect was set up for a | Set up for a
using ProASIC™"S | ProASIC device and the | ProASIC™"® device.
devices. device is actually

ProASIC™S,

5 Programming set | The A500K device Power the VDDL
up problem. Also senses the VDDL power | down during
known as Entering | supply as being on. programming. Check
ISP Failure. the device has the

correct voltages on
VDDP, VDDL, VPP,
and VPN.

6 The IDCODE of The device targeted in Choose the correct
the target device the STAPL file does not | STAPL file and select
does not match the | match the device being the correct device.
expected value in | programmed. Measure JTAG pins
the STAPL file. User selected wrong and noise or
This is a JEDEC device. reflection. TRST
standard message. | Device TRST pin is should be floating or

grounded. tied high.
Noise or reflections on Cut down the extra
one or more of the JTAG | length of ground
pins caused by the IR connection.
Bits reading it back
incorrectly.

7 Unknown This occurs with current | Re-generate STAPL

algorithm: alg=x,
prev=x Invalid data
read from device

STAPL files when the
revision written into the
factory row is not rev 1
for ProASICPLUS
devices. The STAPL files

file from Designer 6.1
SP1.

Double check VPP
and VPN
connections.

76



FlashPro Express for Libero SoC v11.8 User Guide

Exit Code

Exit Message

Possible Cause

Possible Solution

from last year may "exit
7" with newer devices or
the older revision may
cause this failure if the
STAPL file used is from
latest version.

This error can also occur
if the programmer has
trouble reading the
factory row due to signal
noise, crosstalk, or
reflections on the JTAG
signal and clock lines.

It can occur if you
program an -F
ProASICPLUS device
with an old STAPL file.
This error occurs if you
connected VPP and VPN
the wrong way.

It occurs if there are no
bypass Caps on VPP
VPN, which damaged the
device.

This error may occur if
your power supply
cannot source the correct
current for programming.

Make sure VPP and
VPN have correct
bypass caps.

Make sure that your
power supply can
deliver the correct
current during
programming.

8 FPGA failed during | The device is secured, Load the correct
the erase and the corresponding STAPL file.
operation. STAPL file is not loaded.

The device has been
permanently secured and
cannot be unlocked.

11 FPGA failed verify | The device is secured Load the correct

and the corresponding STAPL file.

STAPL file is not loaded. | Use later software
You used the Libero IDE | versions —at least
software v2.3 or earlier or | Libero v2.3 SP1 and
the Designer R1-2003 Designer R1-2003
software or earlier to SP1.

generate the STAPL file. | Double-check the
VPN caps were soldered | VPN bypass caps

in the wrong polarity. polarity.

12 Security is The device is secured
enabled. and the wrong

key/STAPL file was
entered.

The device is damaged.
The verification was
interrupted and therefore

& Microsemi
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Exit Code

Exit Message

Possible Cause

Possible Solution

fails, causing the
software to think the
device is secure.

14 Program security
failure.
15 This is a factory During program, erase,
Calibration Data or verify, you must read
CRC error. back Calibration Data
from the FPGA. The data
contains a CRC. You use
the CRC to ensure the
data is not
corrupted/wrong.
Device is damaged.
Noise on the FTAL
signals causes the
programmer to read back
wrong data.
17 The device has The device is secured Load the correct
been secured. and the wrong key or STAPL file.
Write-security is STAPL file was entered.
enabled. The device is damaged.
-54 Failed to access Analog power supplies Connect the analog
Embedded Flash (Vccl5A, Vee33A, power supplies
Memory GNDAQ and GNDA) are | (Vccl5A, Vce33A,
not connected. GNDAQ and GNDA)
-90 Unexpected RCK | Noise on the RCK signal. | Disconnect the RCK
detected. You connected a CLK and make sure TCK
source to the RCK signal. | has a clean signal.
The polarized bypass Separate FlashPros
capacitors on VPP or away from each other
VPN are reversed-biased | while they are
and are affecting the programming Internal
programmer’s VPP or ISP.
VPN output voltage. This | Connect programmer
causes programming to | as an Admin in
fail. Several FlashPros FlashPro.
are programming at the
same time and are too
close to each other.
Programmer not properly
installed by Admin.
-91 Calibration data Device is damaged. Replace the device.

parity error.

Null

Several FlashPros are
programming at the
same time and are too
close to each other.
FlashPro connects to PC
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Exit Code

Exit Message

Possible Cause

Possible Solution

parallel port through a
dongle key.

Data length mismatch
when performing
DRSCAN on STAPL file.

Cable to target is
not connected

properly.

When the Analyze
command is executed,
the FlashPro looks for
target devices. If the
cable connection is
wrong, FlashPro
assumes that nothing is
connected at all.

Confirm the
connection between
the header to the
device. If the board
supplies the power to
the device, make
sure the voltage level
is correct.

Chain integrity test
failed: xx

The connection between
the FlashPro
programmer and the
device is broken.

The programmer cable
might not be securely
inserted into the header.
The header is not
connected to the JTAG
pins of the FPGA
correctly.

The configuration setting
(ProASIC/ProASICPLUS)
does not match the
target device.

Noise or reflections on
the JTAG pins has
caused communication
between the programmer
and the device to fail.

A dongle is plugged in
between the PC parallel
port and the FlashPro
parallel port cable.

Secure the
connections.

Check the JTAG pins
for signal activity.
Check for broken
TDO, TMS, and TCK
pins.

After checking all
type of connections if
the failure exists, you
may need to replace
the first device (the
devices closest to the
TDO of the
programming header)
in the chain.

Remove the dongle.

Could not connect
to programmer on
port Ip1 or parallel
port device does
not support IEEE-
1284 negotiation
protocol

The remote device does
not respond to the
negotiation protocol, for a
variety of reasons.

Make sure the port is
connected.

Make sure the
connected device is a
FlashPro/Lite
programmer.

Turn the programmer
on.

Check parallel port
setting in BIOS.
Make sure that there
are no dongles in
between the parallel
port and the FlashPro
connection.
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Exit Code

Exit Message

Possible Cause

Possible Solution

Try another parallel
cable, the parallel
cable might be
defective.

Check to see if the
programmer is
damaged.

Make sure the
FlashPro Lite has
power. The FlashPro
Lite is powered from
the target board
through the Vdd pin
of the programming
header.

Make sure the Vdd
pin is connected and
the target board is
powered up.

Secure the
connection between
the cable connector
and the programming
header.

Before you program
any devices, you
should run the self-
diagnostic test. The
diagnostic software
can be found on the
Microsemi web site. If
the test fails, please
contact Microsemi
Customer Technical
Support at
tech@Microsemi.com
for credit and
replacement.

Note: The Self-test is
only available for
FlashPro, not
FlashPro Lite.

External voltage
detected on
<Supply>

The voltage supply for
the FPGA is driven by
another source (board,
external power-supply),
but the user forgot to turn
off the supply in the
Connect menu.

Set appropriate
options in the
Connect menu.

VDPP
Disconnected.

There is no Vddp voltage
supply to the FPGA.

You accidentally turned
off the Vddp supply in the
Connect menu.

Check the Vddp
supply on the board
for appropriate
voltages and correct
the Connect menu.
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Exit Code

Exit Message

Possible Cause

Possible Solution

The Vddp supply on the
board is not functioning.

More than one unidentified device.

If you want to
perform an
operation on the
ProASIC device,
the rest of the
devices in the
chain must be in
bypass mode.

To put devices in
bypass mode,
select
Configuration >
Chain Parameter
(or click the Chain
Parameter button
in the Single
STAPL
Configuration
window), then set
the Pre IR, Pre DR,
Post IR or Post
DR.

STAPL settings of Pre
IR, Pre DR, Post IR, and
Post DR do not match
the chain configuration.
One or more of the
devices in the chain is
damaged and the ID
CODE cannot be read
back.

Make sure you have
set Pre IR, Pre DR,
Post IR, and Post DR
to match the chain
configuration. If you
are still experiencing
the failure, it is likely
that the device's ID
CODE cannot be
read and you need to
replace the device.

Cannot find the
programmer with
ID xxx

The programmer is
removed from the PC.

Delete programmer
(or reconnect
programmer) and
select the Refresh
Programmer button.
See Connecting
Programmers for
more information.

Fatal Error: Please
check programmer
set up.

Software cannot resolve
the error encountered in
the programmer.

Save the project file,
restart the software,
and power cycle the
programmer.

External voltage
xxx mV is detected
on XXX.

You have specified the
programmer to drive the
XXX but external xxx is
detected.

Deselect the xxx in
the programmer
setting.

Executing action
xxx failed.

The STAPL runtime
failed.

Executing action
xxx with serial
index/action xx
failed.

The STAPL runtime
failed.

& Microsemi
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Exit Code

Exit Message

Possible Cause

Possible Solution

No Vpump voltage
source is detected.

Select the Vpump in
the Programmer
setting. Make sure
the external Vpump
is properly turned on.

Vpump short

Use a different

detected. programmer. If the
problem persists,
check the board
layout.

xxx Mhz TCK Check FlashPro Lite

frequency in this
STAPL file is not
supported by the
FlashPro Lite
detected. It
supports only 4
MHz TCK
frequency.

version being used.
Use FlashPro Lite
Rev C or modify the
STAPL file to 4 MHz.

xxx Mhz TCK
frequency in this
STAPL file is not
supported by the
FlashPro Lite
RevC detected. It
supports only 1, 2
or 4 Mhz TCK
frequency.

Modify STAPL file to
1, 2, or 4 MHz.

Cannot find the
serial Index/Action
xxx in STAPL file.

Mismatch between
STAPL file and the
Index/Action selection.

Make sure the
STAPL file was not
overwritten. Save the
project with updated
serial/action
selection.

Duplicated serial
Index/Action xxx
was removed.

Mismatch between
STAPL file and the
Index/Action selection.

Make sure the
STAPL file was not
overwritten. Save the
project with updated
serial/action
selection.

Using local backup
COpY XXX

Cannot find original copy.

Check for available
space on the disk.
Check that write
permissions are
enabled.

FlashPro cannot
rename the
programmer/device

Name is already in use.

Create a new hame.
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Exit Code

Exit Message

Possible Cause

Possible Solution

with an existing
name.

FlashPro cannot
rename the
programmer/device
with an invalid
character.

Invalid character used in

programmer/device
name.

Do not use invalid
characters.

Automatic check
for updates.

FlashPro can check
the Microsemi
website to find if an
updated version of
the software is
available. If you
would like to have
FlashPro
automatically check
for software updates,
choose Preferences
from the File menu.
From the Updates
tab, you can choose
your automatic
software update
settings. You can
also select Software
Updates from the
Help menu for
updates to the
FlashPro software.

FlashPro parse
error.

FlashPro software failed

to parse the file.

FlashPro does not
support STAPL
files for xxx.

STAPL file not allowed.

Use a STAPL file for
your device that is
supported by
FlashPro.

& Microsemi

Power Matters.”
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Electrical Parameters

DC Characteristics for FlashPro5/4/3/3X

Note: The target board must provide the VCC, VCCI, VPUMP, and VJTAG during programming. However,
if there is only one ProASIC3 device on the target board, the FlashPro5/4/3/3X can provide the
VPUMP power supply via the USB port.

Note: The VJTAG signal is driven from the target/DUT board. The VJTAG pin is sensed by the FP4 to
configure the internal input and output buffers to the same IO Voltage levels. The VITAG pin is only
an input pin to the programmer.

Table 5 - DC Characteristic for FlashPro5/4/3/3X

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.35*VJTAG |V
Input high voltage, TDO VIH 0.65*VJTAG | 3.6 \%
Input current, TDO lIL, IH | -20 +20 mA
Input capacitance, TDO 40 pF
Output voltage, VPUMP, VPP +3.0 +3.6 \Y
operating
Output current, VPUMP IPP 250 mA
VJITAG = 1.5V
Output low voltage, TCK, TMS, |VOL 0.0 0.2 \%
TDI, 100pA load
Output low voltage, TCK, TMS, |VOL 0.0 0.30*VJTAG |V
TDI, 4mA load
Output high voltage, TCK, TMS, |V VJIJTAG-0.2 [ VJITAG \Y
TDI, 100pA load
Output high voltage, TCK, TMS, | VOH 0.70*VJTAG | VITAG \Y,
TDI, 4mA load
Output current, TCK, TMS, TDI 10L, -4 +4 mA

IOH

VJITAG = 1.8V
Output low voltage, TCK, TMS, |VOL 0.0 0.2 \Y
TDI, 100pA load
Output low voltage, TCK, TMS, |VOL 0.0 0.3 \%
TDI, 6mA load
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Description Symbol Min Max Unit

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VITAG \%

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 1.25 VITAG \Y

TDI, 6mA load

Output current, TCK, TMS, TDI | IOL, -6 +6 mA
IOH

VJITAG = 2.5V

Output low voltage, TCK, TMS, |VOL 0.0 0.2 \Y

TDI, 100pA load

Output low voltage, TCK, TMS, |VOL 0.0 0.6 \%

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VJITAG \%

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 1.8 VITAG \%

TDI, 8mA load

Output current, TCK, TMS, TDI 10L, -8 +8 mA
IOH

VITAG = 3.3V

Output low voltage, TCK, TMS, |VOL 0.0 0.2 \Y

TDI, 100pA load

Output low voltage, TCK, TMS, |VOL 0.6 \Y

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VITAG \%

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 2.4 VITAG \Y

TDI, 8mA load

Output current, TCK, TMS, TDI | IOL, -8 +8 mA
IOH

DC Characteristics for FlashPro Lite

Table 6 - DC Characteristic for FlashPro Lite

Description Symbol Min Max | Unit
Input low voltage, TDO VIL -0.5 0.7 \%
Input high voltage, TDO VIH 1.7 5.0 \%
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Description Symbol Min Max | Unit
Input current, TDO 1L, 1IH -10 +10 uA
Input capacitance, TDO 40 pF
Input voltage, VDD, operating (see note) +2.3 |+3.5 \%
Input voltage, VDD, power off -1.0 +1.0 \%
Input current, VDD IVDD 500 mA
Output voltage, VPP, operating VPP +15.9 | +16.5 |V
Output voltage, VPN, operating VPN -13.8 | -134 | V
Output current, IPP IPP 0 35 mA
Output current, IPN IPN 0 -15 mA
Output low voltage, TCK, TMS, TDI, 100uA load VOL 0.0 0.2 \%
Output low voltage, TCK, TMS, TDI, 1mA load VOL 0.0 0.5 \Y
Output low voltage, TCK, TMS, TDI, 2mA load VOL 0.0 0.8 \Y
Output high voltage, TCK, TMS, TDI, 100uA load VOH 2.1 2.5 \%
Output high voltage, TCK, TMS, TDI, 1mA load VOH 1.9 2.5 \Y
Output high voltage, TCK, TMS, TDI, 2mA load VOH 1.6 2.5 \Y
Output current, TCK, TMS, TDI, nTRST IOL, IOH | -2 +2 mA

Power Matters.”

Note: Up to 3.5 V can be supplied to the FlashPro Lite on the VDD pin. However, if the VDD supply for the
FlashPro is also connected to the APA VDD supply, the voltage for the VDD pin cannot exceed 2.7 V.

DC Characteristics for FlashPro

Table 7 - DC Characteristic for FlashPro

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.30* \%
VDDP
Input high voltage, TDO VIH 0.70 * 5.5 \%
VDDP
Input current, TDO 1L, HH -10 +10 UA
Input voltage, VDDP, VDDL 0 5.25 \Y
Input voltage, VPP 0 21.0 \%
Input voltage, VPN -21.0 \%
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Description Symbol Min Max Unit
Input current, VDDP, VDDL, VPN, VP IVCC 5.0 mA
Output voltage range, VDDP VDDP 15 3.3 \%
Output voltage range, VPP VPP 15.0 18.0 \%
Output voltage range, VPN VPN -16.0 -12.0 \%
Output voltage resolution / Acccuracy 100/ £50 mV
Output current, IDDP IDDP -135* +135 mA
Output current, IDDL IDDL -135* +135 mA
Output current, IPP IPP -2701* +270 mA
Output current, IPN IPN -270 +270! mA
Output low voltage, TCK, TMS, TDI, OUTO, | VOL 0.0 0.4 \Y
NTRST
Output high voltage, TCK, TMS, TDI, OUTO, | VOH 0.85* +0.3 \%
NnTRST VDDP VDDP
Output current, TCK, TMS, TDI, OUTO, 10L, -12 +12 mA
NTRST IOH

Note: Note (1): When power supply mode is set to ABI_GROUND.

Power Matters.”

Note: * - If you want to power-up the device from the board power supply, clear the checkboxes for VDDL
and VDDP. VPP and VPN are required during programming only and are supplied by the FlashPro

programmer.

Note: (2) Microsemi does not have operating temperature information for the FlashPro programmer.
FlashPro is intended to be used as lab or production equipment and not tested at extreme
temperatures. All devices in the unit are commercial temp. FlashPro4 went through a burn-in cycle
operating at 100C for 250 hours during quality testing. This involved repeatedly powering the
programmers and then programming after the burn in; they are not actively programming during the

burn in.
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Electrical Specifications

FlashPro5

The FlashPro5 is a JTAG and a SPI based programmer for flash based Microsemi devices.

The FlashPro5 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro5 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10
pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro5 10-pin connector are shown in the figure below.

TCK/SCK | 1 2 loND & ~—
——e=-TOO 500 | 3 4 |PROG_MODE ——
-—T.HS-‘SS#[ 5 6 |VITAG =-——
e \pump |7 8 |nTRST ———
ToISDl |9 10 |GND @ —=—»

Figure 17 - FlashPro5 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 8 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK/SCK JTAG clock; SPI clock
TDI/SDI JTAG data input to device; SPI MOSI
TDO/SDO JTAG data output from device; SPI MISO
TMS/SS# JTAG mode select; SPI Chip Select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE | IGLOO v2_family - Used for switching from VCC 1.2V to 1.5V during
programming
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST"” flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.
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Electrical Specifications

FlashPro4

The FlashPro4 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro4 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10
pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version..

The signals on the pins of the FlashPro4 10-pin connector are shown in the figure below (extracted from
FlashPro4 product specification):

-—  TCK|1 2 |gNp  =——
—  TD0|3 4 |PROG_MODE —=
-— TM5[5 6 |VITAG —=—
- Voume |7 g |nTRST —m»
-~ TDI|9 10 |GND —<—Hm

Figure 18 - FlashPro4 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 9 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
TMS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE | IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during
programming

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
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state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro3

Note: FlashPro3 is not supported on Windows 8.1.

The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro3 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro5/4/3/3X and use
the 10 pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro3 10-pin connector are shown in the figure below (extracted from
FlashPro3 product specification):

- TCK|1 2
— TDO|3 4
*—TMSES 6
-— Voump |7 8
—-— TOI |9 10

GMND
N/C
VITAG

nTR5T
GMND

Figure 19 - FlashPro3 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 10 - FlashPro3 Signal Description

Signal

Description

VPUMP

3.3V Programming voltage

GND

Signal reference

TCK

JTAG clock

TDI

JTAG data input to device

TDO

JTAG data output from device

TMS

JTAG mode select

NTRST

Programmable output pin may be set to off, toggle, low, or high level

VITAG

Reference voltage from the target board

N/C

Programmer does not connect to this pin
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the

JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro Lite

For FlashPro Lite, the existing 26-pin connector is shown in the figure below.

N/C|1 2 |N/C

N/C|3 4 IN/C
N/C|5 6 |Vee -
-~ GND|7 8 Ve —
- GNDJ 9 10 [SENSE S
-— GND| 11 12 |TCK —
N/C| 13 14 |TDI —
N/CL15 16 |TDO S —
-— GNDI17 18 |TMS —
- - GND|19 20 |OUTO/RCK ——
N/C |21 22 InTRST —
N/C|23 24 Voo -—
N/C 25 26 |\Vop -—

Figure 20 - 26-pin Connector for FlashPro Lite

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The appropriate SAMTEC micro connector target cable for this is:
Samtec FFSD-13-D-12.00-01-N.

The 12 inch cable is specified. This is likely to be more than enough to connect to the board and reducing
the inductance will help compared with 18 inches, which is supplied by the default with FlashPro Lite.
See the table below for a description of the signals.

Table 11 - FlashPro Lite Signal Description

Signal Description
VDDP VDD supply for logic I/O pads
VDDL VDD supply for core
VPP Positive programming supply (+16.5V)
VPN Negative programming supply(-13.8V)
GND Signal reference
SENSE Input from target board to programmer to indicate connection to ground
TCK JTAG clock
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Signal Description
TDI JTAG data input to device
TDO JTAG data output from device
TMS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
RCK/OUTO | Programmable output pin may be set to off, toggle, low, or high level
N/C Programmer does not connect to this pin

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro

For FlashPro, you can use the same 26-pin target cable you used for FlashPro Lite, but the connections are
shown in the figure below.

-—  2.5V/3.3V|1 2 |Vooe —
-  2.5V/3.3V|3 4 |Voop .
-~  2.5V/3.3V|5 6 |Vee S
- GND|7 8 |Ven —
- GNDlg 10 |SENSE -—
- GND| 11 12 |[TCK -

N/C| 13 14 | TDI -

N/CL.15 16 |[TDO -
-— GNDI17 18 |[TMS -
- GND|19 20 |RCK/OUTO —*
— 2.5V 21 22 InTRST -
-— 2.5V |23 24 [Voou —
- 2.5V |25 26 | VoL —

Figure 21 - 26-pin connections for FlashPro

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows the signal pin descriptions for FlashPro.
Table 12 - FlashPro Signal Description

Signal Description

VDDP VDD supply for logic I/O pads
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Signal Description

VDDL VDD supply for core

VPP Positive programming supply (+16.5 V)

VPN Negative programming supply (-13.8 V)

GND Signal reference

SENSE Input from target board to programmer to indicate connection to
ground

TCK JTAG clock

TDI JTAG data input to device

TDO JTAG data output from device

T™MS JTAG mode select

NTRST Programmable output pin may be set to off, toggle, low, or high
level

RCK/OUTO Programmable output pin may be set to off, toggle, low, or high
level

2.5V, 2.5V/3.3V, Programmer does not connect to these pins

N/C

& Microsemi
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to

select this flag.

FlashPro 5/4/3/3X Characteristics

Table 13 - JTAG Switching Characteristics for FlashPro5/4/3/3X

Description Symbol Min | Max | Unit
Output delay from TCK to TDI, TMS TTCKTDI -2 2 ns
TDO setup time before TCK rising, VITAG=3.3 TTDOTCK |12 ns
TDO setup time before TCK rising, VITAG=1.5 TTDOTCK |14.5 ns
TDO hold time after TCK rising TTCKTDO |0 ns
TCK period TTCK 41.7 | 10667 |ns
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FlashPro and FlashPro Lite Characteristics

The table below shows the JTAG switching characteristics for FlashPro and FlashPro Lite measured at the
programmer end of the JTAG cable.

Table 14 - JTAG Switching Characteristics for FlashPro and FlashPro Lite

Description Symbol Min | Max [ Unit
Output delay from TCK falling to TDI, | TTCKTDI 2 |2 ns
TMS
TDO setup time before TCK rising TTDOTCK 5.0 ns
TDO hold time after TCK rising TTCKTDO | 0 ns
TCK period TTCK 40 |10240|ns

lllustration of the JTAG Switching Characteristics

The figure below is an illustration of the JTAG switching characteristics.

X

TCK

TMS, TDI

N/
-+—[7cx -

Troxro —=

TTDCT:KAP‘

TrckToo—m
Figure 22 - JTAG Switching Characteristics
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FlashPro Express Reference

FlashPro Express Start Page

The FlashPro Express Start Page is the first page to show when the tool starts up. This page provides the
interface for loading a project into the tool by either navigating to the project location, or clicking on one of
the recently opened projects.

E FlashPro Express EI@

Project Edit View Programmer Help

Oper...

Recent Projects List

ChllsershptgatDesktoph3AF ashprotdemo_10_devices\demo_10_devices.pro s
CihlsershptgatDesktoph S38Fashprottest_agfpitestpro
Divhamdyatdemao_10_devices\demo_10_devices.pra
ChlifStand_Alone_FlashPro_Testinghparallel_prograrmmingitest_agfphtest.pro
Devtermphsdlnendsdlnewpro

S Microsemi

Log F X

QErrors &, Warnings olnfo

Figure 23 - FlashPro Express Start Page

FlashPro Express Project Menu

Command Function
Create Job Project from New job project folder with programming job name will
Programming Job be created at the specified location.
Open Job Project Loads a job project into the tool by reading the
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Command

Function

information in user specified .pro file.

Close Job Project

Closes the current job project

Save Job Project

Saves the current job project

Set Log File

Sets the location of the Log file to your specified
location.

Export Log File

Exports the Log file to your specified location.

Execute Script

Runs your specified Tcl script.

Export Script File

Exports all commands run in this session to your
specified path as a Tcl script

Exit

Exits FlashPro Express

FlashPro Express Edit Menu

Power Matters.”

Command Function

Clear Log Window

Clears the Log window

FlashPro Express View Menu

The View menu shows or hides the FlashPro Express GUI elements.

Command

Function

Log Window

Shows/hides the Log window

FlashPro Express Tools Menu

Command Function
Programmer Opens the Programmer Settings dialog box; enables you to set
Settings options for all types of supported Microsemi programmers
Run Runs the current Programming Action.
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FlashPro Express Help Menu

Command

Function

Help Topics

Opens the help

Microsemi Technical
Support

Opens the Microsemi technical support site.

Microsemi Web Site

Opens the Microsemi website in your default browser

User Guide

Opens the FlashPro Express User Guide.

Check for Software
Updates

Checks for software updates (works only if you are
connected to the internet)

About FlashPro Express

Lists the FlashPro Express release information

FlashPro Express Log Window and Status Bar

FlashProExpress Log Window

& Microsemi
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The FlashPro Express log window shows status messages for user activity. Click on the appropriate tab
(Messages, Errors, Warning, Info) to filter messages by type.

e Use the right-click menu to copy text, clear the log, and scroll the log.
e Use the def variable LOG_WINDOW_BUFFER_SIZE to set the buffer size.
e Use the View menu to show or hide the Log window.

FlashProExpress Status Bar

The Status Bar at the bottom displays the status of the load project action.

Close Job Closes the current job project

Project

Save Job Saves the current job project

Project

Set Log File Sets the location of the Log file to your specified location.

Export Log File | Exports the Log file to your specified location.

Execute Script | Runs your specified Tcl script.

Export Script Exports all commands run in this session to your specified path as a
File Tcl script
Exit Exits FlashPro Express
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Command

Function

Clear Log Window

Clears the Log window

FlashPro Express View Menu

The View menu shows or hides the FlashPro Express GUI elements.

Command

Function

Log Window

Shows/hides the Log window

FlashPro Express Tools Menu

Command Function
Programmer Opens the Programmer Settings dialog box; enables you to set
Settings options for all types of supported Microsemi programmers
Run Runs the current Programming Action.

FlashPro Express Help Menu

Command

Function

Help Topics

Opens the help

Microsemi Technical
Support

Opens the Microsemi technical support site.

Microsemi Web Site

Opens the Microsemi website in your default browser

User Guide

Opens the FlashPro Express User Guide.

Check for Software
Updates

Checks for software updates (works only if you are

connected to the internet)

About FlashPro Express

Lists the FlashPro Express release information
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FlashPro Express Log Window and Status Bar

FlashProExpress Log Window

The FlashPro Express log window shows status messages for user activity. Click on the appropriate tab
(Messages, Errors, Warning, Info) to filter messages by type.

e Use the right-click menu to copy text, clear the log, and scroll the log.
e Use the def variable LOG_WINDOW_BUFFER_SIZE to set the buffer size.
e Use the View menu to show or hide the Log window.

FlashProExpress Status Bar
The Status Bar at the bottom displays the status of the load project action.
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